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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal 
injury or death, property damage, or economic loss. 

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures. 

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will 
cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for 
Personal Protective Equipment (PPE). 

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are not in
alignment with the movement toward inclusive language in technology. We are proactively collaborating with industry peers to
find alternatives to such terms and making changes to our products and content. Please excuse the use of such terms in our
content while we implement these changes.
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Preface 

The Getting Results Guide provides you with information on installing and 
using FactoryTalk® Linx Gateway. 

 
Tip: The Getting Results Guide is included in a portable document format (PDF) on your FactoryTalk Linx 
Gateway software installation DVD. These files must be viewed using the Adobe® Acrobat® Reader 
software. 

This section includes the following information: 

• Intended audience 
• Where to find additional information 
• Legal notices 

You should be familiar with: 

• Microsoft® Windows® operating systems 
• FactoryTalk Linx (previously called RSLinx Enterprise) 
• Allen-Bradley® programmable logic controllers (PLCs) and 

programmable automation controllers (PACs) 
• Rockwell Automation control system development software 

For additional information about FactoryTalk Linx Gateway, consult the 
following resources: 

 

The Help includes overview, procedural, screen, and reference information 
for the product. The Help contains these basic components: 

• Overview topics 
• Quick-start topics 
• Step-by-step procedures 
• Dialog box descriptions 

To view the Help, click Help in the FactoryTalk Linx Gateway Configuration 
Tool. 

The Release Notes provide information updates that are necessary to use 
FactoryTalk Linx Gateway effectively. The Release Notes contains the 
following components: 

• System requirements 
• System features 
• Anomalies 
• Functional changes 
• Application notes 

To view the FactoryTalk Linx Gateway Release Notes, download them from the 
Product Compatibility and Download Center 
http://www.rockwellautomation.com/compatibility/#/scenarios. 

The Rockwell Automation Customer Support Center offers an extensive 
online database that includes frequently asked questions and the latest 

About this publication 

Intended audience 

Find additional information 

Help 

Release Notes 

Knowledgebase 

http://www.rockwellautomation.com/compatibility/#/scenarios
http://www.rockwellautomation.com/compatibility/#/scenarios
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patches. The Knowledgebase web page leads to a comprehensive, searchable 
database of support information for all Rockwell Automation products.  

To access the Knowledgebase web page, visit 
http://www.rockwellautomation.com/support, then select Knowledgebase 
Support Center. 

Questions concerning installation and use of FactoryTalk Linx Gateway 
software are handled by the Rockwell Automation Customer Support Center. 
The center is staffed Monday through Friday, except on U.S. holidays, from 8 
a.m. to 5 p.m. Eastern time zone for calls originating within the U.S. and 
Canada. 

To reach the Customer Support Center, call 440-646-3434 and follow the 
prompts. For calls originating outside the U.S. or Canada, locate the number 
in your country by visiting 
https://rockwellautomation.custhelp.com/app/phone. 

When you call, you should be at your computer and be prepared to provide the 
following information: 

• The product version number 
• The type of hardware you are using 
• The exact wording of any errors or messages that appeared on your 

screen 
• A description of what happened and what you were doing when the 

problem occurred 
• A description of how you tried to solve the problem 

 

Rockwell Automation offers a wide range of training programs, from 
regularly scheduled classes to custom-tailored classes conducted at your site. 

If you need more information about these training programs, visit the 
Rockwell Automation site or contact the Rockwell Automation Training 
Coordinator. The web site address and telephone numbers are available at the 
bottom of the back cover. 

Rockwell Automation provides expert consulting and turnkey 
implementations for making optimal use of Rockwell Automation software 
products. Please contact your local representative for more information. 

Rockwell Automation publishes legal notices, such as privacy policies, license 
agreements, trademark disclosures, and other terms and conditions on the 
Legal Notices page of the Rockwell Automation website. 

Technical support 

Training programs 

Consulting services 

Legal Notices 

http://www.rockwellautomation.com/support
https://rockwellautomation.custhelp.com/app/phone
https://www.rockwellautomation.com/global/legal-notices/overview.page
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End User License Agreement (EULA) 
You can view the Rockwell Automation End User License Agreement (EULA) 
by opening the license.rtf file located in your product's install folder on your 
hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf. 

Open Source Software Licenses 
The software included in this product contains copyrighted software that is 
licensed under one or more open source licenses.  

You can view a full list of all open source software used in this product and 
their corresponding licenses by opening the oss_license.txt file located in your 
product's OPENSOURCE folder on your hard drive. This file is divided into 
these sections: 

• Components 
Includes the name of the open source component, its version number, 
and the type of license. 

• Copyright Text 
Includes the name of the open source component, its version number, 
and the copyright declaration. 

• Licenses 
Includes the name of the license, the list of open source components 
citing the license, and the terms of the license. 

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\<product name>\Release 
Notes\OPENSOURCE\oss_licenses.txt.  

You may obtain Corresponding Source code for open source packages 
included in this product from their respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: 
http://www.rockwellautomation.com/global/about-us/contact/contact.page. 
Please include "Open Source" as part of the request text. 

The following table lists the commercially licensed software components in 
FactoryTalk Linx Gateway. 

Component Copyright 

Softing OPC UA C++ Server SDK for Windows V5.66.1 Copyright Softing Industrial Automation GmbH 2009 - 2021 

 

 

http://www.rockwellautomation.com/global/about-us/contact/contact.page
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Chapter 1 

Welcome to FactoryTalk Linx Gateway 

This chapter includes the following information: 

• What is FactoryTalk Linx Gateway? 
• Overview of basic concepts 
• Quick start: Set up and use FactoryTalk Linx Gateway 

FactoryTalk® Linx™ Gateway is an OPC Unified Architecture (UA) and Classic 
Data Access (DA) data server. It allows OPC clients to connect to and access 
tag data from FactoryTalk applications that contain FactoryTalk Linx and 
FactoryTalk View SE servers. FactoryTalk Linx Gateway can send data to, and 
retrieve data from, any FactoryTalk Live Data server or OPC server that is 
defined within a FactoryTalk system. 

FactoryTalk Linx Gateway consists of: 

• A service that provides tag data to OPC DA clients. 
• A service that provides tag data to OPC UA clients. 
• A configuration tool that configures the runtime operation of the 

service. The configuration tool enables the selection of the area or 
application, from which you want to access data (called the scope) as 
well as to start and stop the service. 

Use FactoryTalk Linx Gateway if you need to: 

• Use FactoryTalk Linx as a data server for OPC clients. 
• Use FactoryTalk View SE as a data server for OPC clients to access HMI 

server tags (such as alarm, derived, and system tags) and direct 
references. 

IMPORTANT • FactoryTalk Linx Gateway service starts and stops from the machine on which it 
is installed. 

• FactoryTalk Linx Gateway supports OPC client notification under normal 
shutdown conditions. However, it is the OPC client's responsibility to provide a 
mechanism to detect when it is no longer connected to the server and flag data 
as bad quality. 

• Your access to, and actions within, FactoryTalk Linx Gateway are controlled by 
FactoryTalk Security settings.  

Only one FactoryTalk Linx Gateway is permitted to run on a given computer. 
The activation type determines feature support and the maximum capacity of 
unique tags that can be added to the FactoryTalk Linx Gateway server. The tag 
limit is for all unique tags, including active, inactive, and valid tags. However, 
the OPC DA service and UA service tag limits are separate; a 5,000 tag limit 
activation can simultaneously serve 5,000 tags to DA clients and 5,000 tags to 
UA clients. All FactoryTalk Linx Gateway activations support a capacity of up 
to 20 simultaneous OPC DA or OPC UA client connections. 

What is FactoryTalk Linx 
Gateway? 
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FactoryTalk Diagnostics and FactoryTalk Diagnostics Counter Monitor 
provide alerts when FactoryTalk Linx Gateway has reached the maximum tag 
capacity. This capacity can be increased with additional activations. Refer to 
About Activations on page 75 for more information about activations. 

Before FactoryTalk Linx Gateway version 6.00.00, here are the available 
activations: 

Activation Name Activation Tag Limit FactoryTalk Directory Distributed 
Network 

Activates FactoryTalk Linx 
Data Bridge 

FactoryTalk Gateway Distributed RSOPCD.UNLTD 500,000* Local or Network  Y N 

FactoryTalk Gateway Distributed 
70K 

RSOPCD.70000 70,000 Local or Network Y N 

FactoryTalk Gateway Distributed 
32000 

RSOPCD.32000 32,000 Local or Network  Y N 

FactoryTalk Gateway Station 32000 RSOPCS.32000 32,000 Local N N 
FactoryTalk Gateway Distributed 
5000 

RSOPCD.5000 5,000 Local or Network Y N 

FactoryTalk Gateway Station 5000 RSOPCS.5000 5,000 Local N N 
FactoryTalk Gateway Distributed 
1500 

RSOPCD.1500 1,500 Local or Network Y N 

FactoryTalk Gateway Station 1500 RSOPCS.1500 1,500 Local N N 

From FactoryTalk Linx Gateway version 6.00.00, only the four activations 
below are available for new users. However, the other legacy activations used 
in previous versions of the product are still supported. 

Activation Name Activation Tag Limit FactoryTalk Directory Distributed 
Network 

Activates FactoryTalk Linx Data 
Bridge 

FactoryTalk Linx Gateway 
Professional 

LINXGW.PROFESSIONAL 500,000* Local or Network Y Y 

FactoryTalk Linx Gateway 
Distributed 

LINXGW.DISTRIBUTED 32,000 Local or Network Y N 

FactoryTalk Linx Gateway 
Standard 

LINXGW.STANDARD 5,000 Local or Network  N N 

FactoryTalk Linx Gateway 
Basic 

LINXGW.BASIC 1,000 Local or Network  N N 

 

 
Note: Starting from FactoryTalk Linx Gateway version 6.30.00, Professional activation tag limit is 
changed from unlimited to 500,000. 

500,000* : Default tag limit. You can edit it in the FactoryTalk 
Administration Console (System > Policies > FactoryTalk Linx 
Gateway > FactoryTalk Linx Gateway Policy > Tag count limitation 
for professional activation). 

 

From FactoryTalk Linx Gateway version 6.21.00, three activations are added 
for users. 

Activation Name Activation Tag Limit FactoryTalk Directory Distributed 
Network 

Activates FactoryTalk Linx Data 
Bridge 

FactoryTalk Linx Gateway 
Extended 

LINXGW.EXTENDED 15,000 Local or Network  N N 
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FactoryTalk Linx Gateway 
Embedded 

Verifies its operating on a CompactLogix 5480 
windows core 

500 Local or Network  N N 

FactoryTalk Linx Data Bridge 
Embedded 

Verifies its operating on a CompactLogix 5480 
windows core 

500 Local or Network  N Y 

For more information regarding OPC, refer to the OPC Foundation Web site: 
https://opcfoundation.org 

Because FactoryTalk Linx Gateway enables OPC clients to connect to 
FactoryTalk applications, it is important to understand some basic concepts 
about FactoryTalk. For more detailed information about FactoryTalk, refer to 
the FactoryTalk Services Platform Help. 

Formerly known as FactoryTalk Automation Platform, the FactoryTalk 
Services Platform is an underlying architecture and set of services that 
Rockwell Automation software products build upon. 

The FactoryTalk Services Platform: 

• Provides common services (such as diagnostic messages, health 
monitoring services, access to real-time data) and shares plant 
resources (such as tags and graphics) throughout an automation 
system. 

• Allows defining plant-floor resources once, and then allows 
simultaneous access to those resources across product boundaries. 

• Supports centralized security services. 

The FactoryTalk Services Platform includes the following components: 

• FactoryTalk Directory 
• FactoryTalk Live Data 
• FactoryTalk Diagnostics 
• FactoryTalk Administration Console 
• FactoryTalk Security 
• FactoryTalk Activation Manager 

FactoryTalk Directory allows products to share a common address book, 
which finds and provides access to plant-floor resources, such as data tags 
and graphics. 

The FactoryTalk Services Platform includes two separate directories: a Local 
Directory and a Network Directory. In a Local Directory, a Directory Server, 
all project information, and all participating software products are located on 
a single computer. Local applications cannot be shared across a network. A 
Network Directory organizes project information from multiple FactoryTalk 
products across multiple computers on a network. 

FactoryTalk Live Data manages connections between FactoryTalk products 
and data servers. It reads values from and writes values to OPC Unified 
Architecture (UA), OPC Classic Data Access (DA), and Live Data servers on 
behalf of client software products, such as FactoryTalk View and FactoryTalk 
Transaction Manager. 

Overview of basic concepts 

FactoryTalk Services 
Platform 

FactoryTalk Directory 

FactoryTalk Live Data 

https://opcfoundation.org/
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FactoryTalk Diagnostics collects and provides access to activity, status, 
warning, and error messages generated throughout a FactoryTalk system. 

FactoryTalk Administration Console is an optional, stand-alone tool that 
enables you to configure and manage FactoryTalk-enabled applications. 

FactoryTalk Security offers centralized security services that provides the 
ability to control access to your automation system. Your access to, and 
actions within, the FactoryTalk Linx Gateway tool are controlled by 
FactoryTalk Security settings. Refer to Secure FactoryTalk Linx Gateway using 
FactoryTalk Security on page 91 before attempting to configure FactoryTalk 
Linx Gateway. 

FactoryTalk Activation Manager provides a secure, software-based system for 
activating Rockwell Automation software products and managing software 
activation files. 

An application organizes project information, including elements such as 
data servers, HMI servers, and alarm and event servers, and makes it available 
to FactoryTalk-enabled software products that support the same FactoryTalk 
Directory type. 

• Network applications are held in a FactoryTalk Network Directory.
Project information and participating software products can be
located on multiple computers distributed across a network. All of the
computers participating in a particular Network application share a
common Network Directory Server located on a network computer.

• Local applications are held in a FactoryTalk Local Directory. Project
information is located on a stand-alone computer and is available only
to software products installed on that same local computer. Local
applications cannot be accessed remotely and cannot share project
information with a Network application.

IMPORTANT • Ensure all components intended for use in the same FactoryTalk system 
support the same FactoryTalk Directory types. 

• The installed FactoryTalk Linx Gateway activation may limit support for 
FactoryTalk Directory types. For details on which FactoryTalk Directory types 
are supported by a certain activation, see Activation types on page 76.

IMPORTANT If there is a possibility that a client will attempt to access tags during setup, before 
continuing, shut down all OPC clients and inhibit FactoryTalk Linx Gateway services using 
FactoryTalk Linx Gateway Configuration Tool > Server Configuration. This prevents 
the services from automatically starting while making changes. 

Use the following checklist to guide you through the process of setting up and 
using FactoryTalk Linx Gateway. 

Step Description Refer to: 
 1. Read and understand the FactoryTalk Linx Gateway 

Getting Results Guide. 

 2. Verify your personal computer meets the minimum 
hardware and software requirements. 

System requirements on page 17 

FactoryTalk Diagnostics 

FactoryTalk Administration 
Console 
FactoryTalk Security 

FactoryTalk Activation 
Manager 

Application types 

Quick start: Set up and use 
FactoryTalk Linx Gateway 
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 Step Description Refer to: 
 3. Install FactoryTalk Linx Gateway. Install FactoryTalk Linx Gateway on 

page 17 
 4. Install a valid FactoryTalk Linx Gateway activation. About Activations on page 75 

 5. Configure FactoryTalk Security, if required. FactoryTalk Services Platform Help 

 6 Create a FactoryTalk application (or point to an existing 
application). 

FactoryTalk Services Platform Help 

 7. Add a FactoryTalk Linx data server or an HMI server. FactoryTalk View Site Edition Help or 
FactoryTalk Services Platform Help. 

 8. Create a shortcut between the FactoryTalk application 
and the server or controller. 

FactoryTalk View Site Edition Help or 
FactoryTalk Services Platform Help. 

 9. Start FactoryTalk Linx Gateway by clicking Start > 
Programs > Rockwell Software > FactoryTalk Linx 
Gateway > FactoryTalk Linx Gateway Configuration. 

Start FactoryTalk Linx Gateway 

 10. Select the scope using the FactoryTalk Linx Gateway 
Select FactoryTalk Directory dialog box. 

About the FactoryTalk Linx Gateway 
Scope Selection dialog box on page 
48 

 11. Configure to make sure DA or UA Server in Server 
Configuration tab is running and not inhibited. 

Server Configuration on page 40 

 12. Configure OPC UA server endpoint in the UA Server 
Endpoints tab 

FactoryTalk Linx Gateway Help 

 13. (Optional) Enable and configure tag list and tag list 
access to decide if all data to be available or limit it to 
specific items or if an OPC UA client to be able to access 
structures and arrays. If disable all available tags from 
FactoryTalk data servers, the tag list will be available to 
all OPC Clients. 

Tag List on page 41 

 14. When the OPC client makes a connection with 
FactoryTalk Linx Gateway, enter FactoryTalk Linx 
Gateway as the server name to which you wish to 
connect. If the OPC client supports browsing, select 
FactoryTalk Linx Gateway from the list of available 
servers. 

OPC client documentation 

 15. If OPC UA endpoint security is enabled, trust incoming 
certificate from the UA client in the Certificate 
Management tab. 

Certificate Management on page 50 

 16. Run the OPC client and select the tags you want to 
access (up to, but not exceeding, the activation count). 

OPC client documentation 
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Chapter 2 

Install FactoryTalk Linx Gateway 

The FactoryTalk Linx Gateway installation DVD provides wizards to guide you 
through the installation process.  

FactoryTalk Linx Gateway supports two installation methods: Setup wizard 
installation and automated installation with command line syntax. This 
chapter uses the Setup wizard installation method to illustrate the steps. The 
automated installation with command line syntax reduces user interaction 
and provides command line parameters to install FactoryTalk Linx Gateway. 
See Install FactoryTalk Linx Gateway with command line syntax on page 79.  

This chapter contains the following information: 

• System requirements 
• Where to install FactoryTalk Linx Gateway 
• Install FactoryTalk Linx Gateway for the first time 
• Update an existing system 
• Install Remote FactoryTalk Linx Gateway 

 

To use FactoryTalk Linx Gateway, your personal computer must meet the 
following minimum hardware and software requirements: 

 

FactoryTalk Linx Gateway requires the following hardware: 

• Intel® Core i5 Standard Power processor  
• Total processor cores is recommended to be no less than 4 for virtual 

machines 
• 4 GB of memory  

 
Tip: When FactoryTalk Linx Gateway is operating on Windows 10 IOT Enterprise (for example, the 
Windows core of a CompactLogix 5480 controller), it is limited to a FactoryTalk Directory and 
FactoryTalk Linx data server running in the same environment (a remote directory and data 
server are not supported). 

 

Tested FactoryTalk Linx Gateway OPC DA service update rates 
CPU and memory requirements for the FactoryTalk Linx Gateway OPC DA 
server increase as tags are set to active (up to the activation tag capacity) or as 
more clients connect to the server (up to the 20 connected client capacity). 

System requirements 

Hardware requirements 

Tested FactoryTalk Linx 
Gateway update rates 
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Rockwell Automation tests with the following update rates for a number of 
active tags. 

Processor Number of 
tags 

Scan rate of all tags Total CPU 
utilization 

Single 70,000 All data changing value every 250 msec 75% 
Dual-core 70,000 All data changing value every 250 msec 50% 
Dual-core 70,000 All data changing value every 1000 msec 20% 

These values are tested on a computer with a dual-core Intel® Core™ i3-2120 
processor, 3.3 GHz, with 4G of RAM. The single core test is run using only one 
of the cores to provide a basis for comparison. FactoryTalk Linx Gateway and 
FactoryTalk Linx are installed and configured on the same computer for the 
test. 

The largest impact on CPU utilization is the rate the data is changing even if 
the data server (in this case, FactoryTalk Linx) is local or remote to the 
FactoryTalk Linx Gateway. 

The total amount of memory used for the runtime tests was approximately 
700MB. Additional memory would be utilized if browsing occurred. 

Tested FactoryTalk Linx Gateway OPC UA service update rates 
CPU and memory requirements for the FactoryTalk Linx Gateway OPC UA 
server increase as tags are set to active (up to the activation tag capacity) or as 
more clients connect to the server. Rockwell Automation tests with the 
following update rates for a number of active tags. This data is captured in 
FactoryTalk Linx Gateway version 6.21.00 with security disabled. 

Number of Active Tags Tested Update Rate (ms) 

50,000 500 
100,000 700 
150,000 1000 
200,000 1500 
250,000 2000 
300,000 2400 

350,000 3000 
400,000 3500 
450,000 4000 
500,000 4500 

Note: This data was based on tests with the UA tag list disabled. 

Number of Active Tags Tested Update Rate (ms) 

10,000 500 
50,000 500 
100,000 500 
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150,000 1000 
200,000 2000 
250,000 2000 

300,000 2000 
350,000 2000 
400,000 2500 
450,000 3000 
500,000 4000 

Note: This data was based on tests with the UA tag list enabled. 

These values are tested on a computer with Win 10 enterprise 64 bit,  8G 
RAM, Intel® Xeon® CPU, E5-2699A v4 @ 2.40 GHz 2.39 GHz 4v CPU . 

FactoryTalk Linx Gateway is tested on operating systems installed from 
original Microsoft® media only. They run on the 64-bit versions of the 
following Windows® operating systems: 

• Windows® 10* (v2004, v20H2, v21H1, and 21H2)

FactoryTalk Linx Gateway adopts .NET 4.8 which is only supported in
Windows 10 v1803 and later.

• Windows 10 IoT Enterprise 2016 LTSB
• Windows 10 IoT Enterprise 2019 LTSC
• Windows 11
• Windows Server® 2012
• Windows Server 2012 R2
• Windows Server 2016
• Windows Server 2019

*For additional information about Windows 10 Support for the FactoryTalk
Suite of Rockwell Software products, refer to Knowledgebase Document ID:
IN4493 - Windows 10 Support for the FactoryTalk Suite of Rockwell Software
products

FactoryTalk Linx Gateway version 6.30.00 (CPR 9 SR 13) was tested with, and 
is compatible with, the following Rockwell Automation® products when used 
on the same computer: 

• FactoryTalk® Activation Manager version 4.06.13
• FactoryTalk Services Platform version 6.30.00
• FactoryTalk View version 13.00.00
• FactoryTalk® Linx™ version 6.30.00

FactoryTalk Linx Gateway Setup wizard supports to automatically install a 
series of Rockwell software and the necessary prerequisite software, 

Software requirements 

Software compatibility 

Prerequisite software 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/964391
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/964391
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including: 

Rockwell Software 

• FactoryTalk Services Platform version 6.30.00 (CPR 9 SR 13)

• FactoryTalk Activation Manager version 4.06.13
• FactoryTalk Alarms and Events version 6.30.00 (CPR 9 SR 13)
• FactoryTalk Linx version 6.30.00 (CPR 9 SR 13)
• Rockwell Automation x64 Driver v2.03.04 (for 64-bit operating

systems)

Prerequisite software 
• FactoryTalk Diagnostics version 6.30.00
• Microsoft .NET Framework 4.8
• Microsoft Visual C++ 2017 Redistributable (x86) 14.15
• Microsoft Visual C++ 2017 Redistributable (x64) 14.15
• Microsoft SQL Server 2012 Native Client 11.4
• Microsoft SQL Server 2012 Native Client x64 11.4
• Microsoft ODBC Driver 13.1 for SQL Server 13.1.811
• Microsoft ODBC Driver 13.1 for SQL Server x64 13.1.811
• OPC Local Discovery 1.03.401
• OPC .NET API 2.01
• Windows Firewall Configuration Utility 1.00.15
• Wibu CodeMeter Runtime Kit v7.30

FactoryTalk Linx Gateway version 6.00.00: 

• Adds OPC UA data access (non-secured endpoint).
• Provides read access to CIP Energy Object information.

FactoryTalk Linx Gateway version 6.10.00: 

• Supports FactoryTalk Security to control configuration
access/changes.

• Supports FactoryTalk Audit tracking for configuration changes.
• Supports OPC UA Secured endpoints with signing and encryption.

FactoryTalk Linx Gateway version 6.20.00: 

• Adds the ability to read/write device data (e.g. PowerFlex Drive, E300
Motor Protector, etc.) using FactoryTalk Linx CIA Messaging.
FactoryTalk Linx Gateway also provides the ability to control access to
this option.

• Adds the ability to allow OPC UA clients accessing multiple values of an
array tag in a single action by configuring the "Index Range"

System features 
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parameter. For example, add an item [shortcut]Tag with index range 
1:3 returns the values of Tag[1], Tag[2], and Tag[3] together. 

• Adds the ability to allow OPC UA clients to directly access the tag 
information without browsing the tag in a client application. This is 
achieved by accessing the tag by entering the object node ID. 

• Supports customized outgoing certificate, import and the ability to 
create a certificate signing request for external Certificate Authority 
(CA) to sign. 

• Adds the ability to allow users to choose the specific activation that will 
be requested on startup. 

FactoryTalk Linx Gateway version 6.21.00: 

• Adds the ability to support tag list to view and edit the tag group, add 
tags to tag group and set tag access rights. The tag list supports 
complex types using array and structures, including the ability to 
import and export the configuration and includes an option to 
manually refresh the namespace available to an OPC UA Client when 
changes are made to the tag list or in other parts of the system (for 
example,Logix on-line changes). 

• Adds new activation type, which is FactoryTalk Linx Gateway 
Extended, with capacity of 15,000 tags. 

• Supports CompactLogix5480 Windows Core embedded activation, 
with a capacity of 500 tags. 

• Adds the ability to support configuration changes without requiring 
Admin rights. 

• Adds the ability to change the Namespace Index that OPC UA clients 
will utilize when accessing the FactoryTalk Linx Gateway’s data model 
when no tag groups or lists are configured. The user interface provides 
an option to select a Namespace Index of (2 or 3). Beginning with 
version 6.20.00, the namespace index presented to OPC UA clients 
defaults to 2. In previous versions, 3 was the default. 

• Adds configuration checks and informs the user when required 
configuration settings are incorrect or missing. (for example, UA 
enabled but no endpoint is defined, tag list selected but no tags 
configured, a client certificate is received but no client certificates are 
trusted). 

• Adds a button on the FactoryTalk Directory scope selection dialog to 
navigate to the FactoryTalk Administration console where FactoryTalk 
Linx and other OPC DA/UA data sources can be configured. 

FactoryTalk Linx Gateway version 6.30.00: 

• Supports Chinese version. 
• Adds an option to change the DA access setting on the Server 

Configuration tab after installation completes. 
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• Adds an option to include additional sub-element references (scalar, 
structure, or array) for all arrays in the namespace provided to OPC UA 
Clients. 

• Adds the ability to include individual array sub-elements (scalar, 
structure, or array) in tag groups. 

• Adds the ability to backup and restore configurations. 
• Adds the ability to specify, refresh, import, or export OPC UA 

namespace index. 
• Adds the ability to restart after the FactoryTalk Directory was restored. 
• Updates installation option to diminish security risk by selecting 

Gateway Server OPC DA and UA (only local DA clients) or Gateway 
Server OPC DA and UA (local or remote DA clients) before installation. 

• Adds the ability to limit access to security certificate management 
operations to administrators or individuals approved by an 
administrator to diminish security risk. 

• Adds the ability to substantially improve or reduce the amount of time 
required to load tag information into the Add Tag dialog. 

• Adds user interface warning when the configuration contains an 
invalid scope or a referenced workstation is renamed. 

• Changes Professional activation tag limit from unlimited to 500,000. 
• Encrypts the configuration files and does not support copying them to 

another computer. Instead, use the Backup and Restore on page 61 
function to reuse the configuration. 

• Downgrades OPC UA service account to Local Service. 
• Raises the default DCOM authentication level to Packet Integrity. 

For FactoryTalk Local Directory applications and network station, you must 
install FactoryTalk Linx Gateway on the local computer. 

In a FactoryTalk Local Directory application and network station, all project 
information and security settings are located on a single computer, and the 
FactoryTalk-enabled system cannot be shared across a network. A FactoryTalk 
Linx Gateway Local Directory and network station, however, can support 
remote OPC clients. Products such as FactoryTalk View Site Edition (SE) 
Station and RSLogix use the Local Directory. 

A FactoryTalk application directories can be configured as Local, Network 
Station, or Network Distributed. These options are determined by the 
capabilities defined by the license/activation that is being used. 

1. Local – Small application where the FactoryTalk Linx or FactoryTalk 
Linx OPC UA Connector communications service is operated on the 
same workstation with FactoryTalk Linx Gateway. A local application is 
configured with a single level where all communications services are 
defined at the same top level (no areas are supported). 

2. Network Station – This configuration uses the Network directory, with 
all of the communications services defined on the same workstation 
with FactoryTalk Linx Gateway. A network station application permits 

Where to install FactoryTalk 
Linx Gateway 
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areas to be created to improve the organization of the application (This 
type of configuration can be used with software like FactoryTalk View 
SE Station or FactoryTalk Historian which does not support Local 
directory). 

3. Network Distributed – This type of directory permits communications 
services to be located on multiple / different workstations from 
FactoryTalk Linx Gateway. Up to ten (10) of each type of 
communications services (FactoryTalk Linx and FactoryTalk Linx OPC 
UA Connector) can be defined in a system. These communications 
services can be configured as redundant to support high availability 
configurations (This type of configuration can be used with software 
like FactoryTalk View SE Distributed). 

Depending on your requirements, FactoryTalk Linx Gateway installation 
options for Local FactoryTalk Directory applications include the following: 

To use FactoryTalk Linx as a data server to HMI and other third-party OPC 
clients, FactoryTalk Linx Gateway, FactoryTalk Linx, and FactoryTalk 
Directory are installed on the same machine as shown in the following 
diagram: 
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For FactoryTalk View Site Edition (SE) applications that need to serve OPC 
data, FactoryTalk View SE Station can also be installed on the same machine, 
as shown in the following diagram. This also provides the benefit of 
FactoryTalk View SE Station features, such as alarm and derived tags and 
direct references. Plus, either FactoryTalk Linx or FactoryTalk View SE Station 
can be used as a data server. 

 

For FactoryTalk Network Directory applications, you can install FactoryTalk 
Linx Gateway on any computer. 

A FactoryTalk Network Directory organizes project information and security 
settings from multiple FactoryTalk-enabled products across multiple 
computers on a network. When a Network Directory is configured on a 
computer, that computer can then be used as a Network Directory Server, or it 
can be made a client of a Network Directory Server configured on a different 
computer on the network. Products such as FactoryTalk View SE Distributed 
and FactoryTalk Transaction Manager use the Network Directory. 

 
Tip: In FactoryTalk Network Directory applications, you can choose from multiple computers to install 
FactoryTalk Linx Gateway. It is recommended that you install FactoryTalk Linx Gateway and the client on 
the same computer, instead of using Remote OPC across the network. Because FactoryTalk Live Data is 
used as the network protocol in what is considered to be a more robust and secure fashion than Remote 
OPC. 

Depending on your requirements, FactoryTalk Linx Gateway provides many 
installation options for FactoryTalk Network Directory applications. 

To connect to multiple FactoryTalk Linx servers or multiple FactoryTalk View 
SE Distributed servers, FactoryTalk Linx Gateway, FactoryTalk Linx, and 
FactoryTalk Directory can be distributed over different machines, as shown in 
the following diagram: 

In this example, one FactoryTalk Linx Gateway is serving all clients. If a 
system requires 32,000 or more tags, use a no fixed limit tag activation and 
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refer to the FactoryTalk Linx Gateway Release Notes > Application Notes for 
tested hardware and update rates. 

You can have multiple FactoryTalk Linx Gateway servers point to the same 
scope in the same FactoryTalk Directory to provide redundancy for each other. 
The client code controls the switching between the FactoryTalk Linx Gateway 
servers. 

FactoryTalk Linx Gateway supports redundant FactoryTalk Linx data servers 
and HMI servers. Refer to the FactoryTalk Services Platform Help for more 
information. 

Starting from version 6.30.00, FactoryTalk Linx Gateway is available with 
limited localized language support. FactoryTalk Linx Gateway provides 
language-specific installation packages that are available as optional 
downloads from the Rockwell Automation download center. 

To download the localized version 
1. Go to Product Compatibility and Download Center (PCDC) and search 

FactoryTalk Linx Gateway to download. 
2. After validating the serial number and the product key, in the 

Available Software dialog, click Show All. 
3. Expand Show Optional Downloads > Localized products. 
4. Select the localized version you want to download. 

5. Click . 

 
Tip: Only one language edition of FactoryTalk Linx Gateway or FactoryTalk Services might be 
installed at a time on a single workstation. 

 

 

Download a localized 
version of FactoryTalk Linx 
Gateway 

https://compatibility.rockwellautomation.com/Pages/home.aspx
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Chapter 3 

About Remote FactoryTalk Linx Gateway 

Remote FactoryTalk Linx Gateway enables an OPC DA client to access a 
remote OPC DA server like FactoryTalk Linx Gateway without installing 
Rockwell Automation software on the OPC DA client computer. It is intended 
for use with OPC DA clients that do not support server enumeration and 
cannot discover or identify remote OPC DA servers. 

During the install, the Remote FactoryTalk Linx Gateway installer configures 
the Windows Firewall and security settings to allow DCOM communications 
between the OPC DA client and Remote FactoryTalk Linx Gateway. 

Remote FactoryTalk Linx Gateway does not have a configuration interface. 
Remote FactoryTalk Linx Gateway does not support connections to OPC UA 
servers. A Remote FactoryTalk Linx Gateway installation is not required for an 
OPC UA client on one workstation to connect to the FactoryTalk Linx Gateway 
OPC UA service on another workstation. 

Install Remote FactoryTalk Linx Gateway (OPC DA client computer 
configuration) on the same computer as an OPC DA client that does not 
support server enumeration. 

Where to install Remote 
FactoryTalk Linx Gateway 
(OPC DA client computer 
configuration) 
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Shown below are multiple OPC DA clients connecting to a single FactoryTalk 
Linx Gateway OPC DA server. Remote FactoryTalk Linx Gateway (OPC DA 
client computer configuration) is installed once per computer that hosts an 
OPC DA client. 

If you install Remote FactoryTalk Linx Gateway on a remote third party OPC 
client, you need to configure Windows firewall to allow connections with the 
FactoryTalk Linx Gateway server. This is automatically configured after 
installation of FactoryTalk Gateway version 3.90.00 and later. If you want to 
verify the setting or make changes, follow the steps below. 

Tip: The following procedure applies Windows Server 2012. 

To configure Windows firewall: 
1. Select Start > Control Panel > System and Security (View by:

Category).
2. In the Windows Firewall section, click Allow a program through 

Windows Firewall.

For Windows 10 or Windows Server 2016, Type Allow an app through 
Windows Firewall in the Windows Search field, and then press Enter.

Configure Windows firewall 
for Remote FactoryTalk Linx 
Gateway 
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3. In the Allowed Programs and features list, verify the program 
OPCTest.exe which FactoryTalk Linx Gateway provided, or your own
application for remote connecting, is in the list. If you cannot find it in
the list, you can click Allow another program to browse and add it to
the allowed programs list.

4. Click OK to save the changes and close the dialog box.

You can install one or more Rockwell Automation software products to a 
single personal computer. 

IMPORTANT The user installing or configuring FactoryTalk Linx Gateway must have administrative 
rights in Windows on the computers where the software is being installed or configured. 
The Windows domain Administrator account has these rights, for example. 

To install FactoryTalk Linx Gateway software: 
1. Start your Windows operating system.
2. Insert the FactoryTalk Linx Gateway DVD into the DVD-ROM drive.
3. (optional) If FactoryTalk Linx Gateway Setup does not appear, start

the setup utility:

a. In Windows, select Start > Run.

b. In Open, type x:\setup, where x is the letter of the drive containing
the FactoryTalk Linx Gateway DVD-ROM, and then click OK.

c. If Microsoft .NET Framework 4.0 or later is not installed on your
computer, the Microsoft .NET Framework Setup dialog box shows.
Click Install.

4. In FactoryTalk Linx Gateway Setup, select a product to install from the
drop down list. The available products are:

• Gateway Server OPC DA and UA (local or remote DA clients)

DCOM remote access permissions are set as ANONYMOUS LOGON
and Everyone to have remote access rights.

• Gateway Server OPC DA and UA (only local DA clients)

DCOM remote access permission is only set as ANONYMOUS
LOGON.

Select Gateway Server OPC DA and UA (local or remote DA clients) or 
Gateway Server OPC DA and UA (only local DA clients) to install 
FactoryTalk Linx Gateway and all supporting FactoryTalk software on 
this computer.FactoryTalk Linx Gateway serves FactoryTalk 
application data from this computer to OPC DA and UA clients. 

• Remote Gateway (DA Client remote configuration)

Install FactoryTalk Linx 
Gateway 
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Select Remote Gateway (DA Client remote configuration) to install 
Remote FactoryTalk Linx Gateway. No other FactoryTalk software is 
installed on this computer. Remote FactoryTalk Linx Gateway 
enables an OPC DA client on this computer to access a remote OPC 
DA server. It is intended for use with OPC DA clients that do not 
support server enumeration and cannot discover or identify remote 
OPC DA servers. 

5. Choose either:

• Install Now: Install FactoryTalk Linx Gateway and prerequisite
software to the the default installation directory: C:\Program Files
(x86)\Rockwell Software.

• Customize: Specify which software should be installed and select a
different installation directory, then click Install.

6. In End-User License Agreements, read the agreements, then select
Accept all to continue the installation, or click Decline to return to the
previous page.

7. (optional) If prompted to restart your computer during the
installation, click Restart now to restart your computer and continue
the installation, or Restart later to suspend and exit the installation.

8. If you are installing FactoryTalk Linx Gateway, Almost there appears.
Select one of the following options, then click Next.

• Select Activate your software to activate FactoryTalk Linx Gateway
now.

• Select Skip activation to activate FactoryTalk Linx Gateway later
using FactoryTalk Activation Manager. For more information, refer
to About Activations on page 75.

If you are installing Remote Gateway, no activation is required. 

9. In That's it!, click Restart now to restart your computer and continue
the installation, or Restart later to exit the installation. You must
restart your computer before using FactoryTalk Linx Gateway.
Meanwhile, you can also:

• Click Installation Summary to see the installation details.
• Click Register for updates to learn how to receive email updates

about product patches.
• Click Download it free to install Adobe Acrobat Reader. Adobe

Acrobat Reader is required to open the FactoryTalk Linx Gateway
Getting Results Guide and other documents.

10. The FactoryTalk Linx Gateway installation is complete. When you
finish installing the software, remove the FactoryTalk Linx Gateway
DVD from the DVD-ROM drive, and store it in a safe place.

Change DA access 
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After installation completes, FactoryTalk Linx Gateway supports changing the 
DA access setting in the Server Configuration on page 40 tab when the 
current FactoryTalk Linx Gateway Configuration is relaunched as 
administrator.  

• Go to Start> FactoryTalk Linx Gateway Configuration> Run as
administrator.

Tip: This configuration will not be backed up. 

To uninstall FactoryTalk Linx Gateway software, do any of the following: 

• Open Programs and Features in Windows Control Panel, right-click
FactoryTalk Linx Gateway and then click Uninstall.

• Open Setup.exe, and then click modify or uninstall.
• Open the Command Prompt window and type a command with the

following syntax:
Setup.exe [/Q | /QS] /Uninstall /Product="Gateway
Server OPC UA and DA (local or remote DA clients)"

Note: Components, such as FactoryTalk Activation Manager, that are shared with other products 
will not be uninstalled. 

For more information about command-line parameter, see Parameters on 
page 79. 

Note the following before upgrading FactoryTalk Linx Gateway: 

• The user installing or configuring FactoryTalk Linx Gateway must have
administrative rights in Windows on the computers where the
software is being installed or configured.

• If you upgrade from RSOPC Gateway 1.00 (CPR 7), do not use
Add/Remove Programs from Windows Control Panel to uninstall
RSOPC Gateway 1.00 (CPR 7). Using this method to remove RSOPC
Gateway 1.00 (CPR 7) deletes RSOPC Gateway 1.00 (CPR 7)
configuration files.

• If you upgrade from FactoryTalk Gateway v3.90 or earlier to
FactoryTalk Linx Gateway v6.00 or later, uninstall FactoryTalk Gateway
using Add/Remove Programs before installing FactoryTalk Linx
Gateway.

Uninstall FactoryTalk Linx 
Gateway 

Update an existing 
installation 
Before you begin 
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Perform the following steps to upgrade to the latest version of FactoryTalk 
Linx Gateway: 

1. Stop the FactoryTalk Linx Gateway services by selecting the Inhibit
checkbox in FactoryTalk Linx Gateway Configuration Tool > Server 
Configuration.

2. If FactoryTalk Diagnostics Counter Monitor is running, exit the
program.

3. Close the FactoryTalk Linx Gateway Configuration Tool.
4. Insert the FactoryTalk Linx Gateway product DVD. Perform the

installation steps as presented on the screen.
5. Restart your computer.

Note: You must restart your computer after installing Rockwell Automation software products. If 
you are installing multiple products, you must restart your computer after all of the products 
are installed. 

Remote FactoryTalk Linx Gateway enables an OPC DA client to access a 
remote OPC DA server like FactoryTalk Linx Gateway without installing 
Rockwell Automation software on the OPC DA client computer. It is intended 
for use with OPC DA clients that do not support server enumeration and 
cannot discover or identify remote OPC DA servers. 

Remote FactoryTalk Linx Gateway does not have a configuration interface. 
Remote FactoryTalk Linx Gateway does not support connections to OPC UA 
servers. 

Upgrade FactoryTalk Linx 
Gateway 

Install Remote FactoryTalk 
Linx Gateway 
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Shown below are multiple OPC DA clients connecting to a single FactoryTalk 
Linx Gateway OPC DA server. Remote FactoryTalk Linx Gateway is installed 
once per computer that hosts an OPC DA client. 

To install Remote FactoryTalk Linx Gateway, select Remote Gateway (DA 
Client remote configuration) in FactoryTalk Linx Gateway Setup, then follow 
the installation instructions. 
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Chapter 4 

Start FactoryTalk Linx Gateway and explore the 
user interface 

This chapter includes the following information: 

• Application authentication level for DCOM security
• Starting FactoryTalk Linx Gateway
• About the FactoryTalk Linx Gateway Configuration dialog box

In response to Microsoft Distributed Component Object Model (DCOM) 
Hardening patch (MS KB5004442), the minimum DCOM authentication level 
used by Rockwell Automation products was raised to Packet Integrity. 

IMPORTANT Installing this product’s latest version with earlier unpatched versions of other 
FactoryTalk products or products using Classic OPC DA connections may cause a loss of 
connectivity due to the difference in DCOM authentication level used. For additional 
information, see the Knowledgebase Document ID: IN39461 - Microsoft DCOM Hardening 
Information TOC. 

Microsoft releases the DCOM Hardening patch in response to 
CVE-2021-26414. This patch elevates the minimum DCOM authentication level 
that is required to establish a DCOM connection. DCOM is used by many 
Rockwell Automation products and may be affected by the change that is 
made by the Microsoft patch. For additional information about the affected 
Rockwell Automation products, see the Knowledgebase Document ID: PN1581 
- Product Notification 2022-01-001 - Rockwell Automation products unable to
establish proper DCOM connection after installing Microsoft DCOM
Hardening patch (MS KB5004442).

Impact on Rockwell Automation software 
If computers within your network have installed the Microsoft patch, the 
DCOM authentication level of the client or server applications on these 
computers is required to update to 
RPC_C_AUTHN_LEVEL_PKT_INTEGRITY, while the authentication level of 
applications on other computers are not. As a result, the communication 
across the two types of computers will fail. 

Tip: 
• The distributed third-party OPC DA server and client applications are also impacted. 
• To ensure proper communication, the authentication level of both the server application and the client 

application should be at the same level. 

Application authentication 
level for DCOM security 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133991
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133991
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
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Solutions 
We recommend installing the latest version of Rockwell Automation software 
or installing the patch for the corresponding software version. 

To avoid the compatibility issue, make sure all Rockwell Automation 
applications you use are updated. 

If any computers within your network have not installed the Microsoft patch 
or some Rockwell Automation applications are not updated to the latest 
version, you can lower the DCOM application authentication level on all 
computers. To do so, do one of the following: 

• Remove the Microsoft DCOM patch from all workstations in the
system.

• Switch the DCOM authentication level on all workstation in the system
using one of the following methods:

• Use Registry Editor.

• FactoryTalk software

• Open Registry Editor, select HKEY_LOCAL_MACHINE >
SOFTWARE > Rockwell Software > FactoryTalk > Platform,
right-click DCOMAuthLevel > Modify, and then edit the Value
data to 1. The default value after upgrading the Rockwell
Automation application is 5
(RPC_C_AUTHN_LEVEL_PKT_INTEGRITY) and the former
value is 1 (RPC_C_AUTHN_LEVEL_PKT_NONE).

• RSLinx Classic software

• Open Registry Editor, select HKEY_LOCAL_MACHINE >
SOFTWARE  > WOW6432Node > Rockwell Software >
RSLinx, right-click DCOMAuthLevel > Modify, and then edit
the Value data to 1. The default value after upgrading the
Rockwell Automation application is 5
(RPC_C_AUTHN_LEVEL_PKT_INTEGRITY) and the former
value is 1 (RPC_C_AUTHN_LEVEL_PKT_NONE).

• Use the DCOMAuthLevel utility.

• Open DCOMAuthLevel, select None (for backward 
compatibility), and then click OK.

Tip: 
• The authentication level lower than 5 will not be supported after installing the 

Microsoft patch. 
• This utility will adjust the Authentication level for FactoryTalk Services Platform, 

FactoryTalk Live Data OPC DA client interface, FactoryTalk Linx Gateway OPC DA 
server interface, and RSLinx Classic’s OPC DA server interface. 

• The Windows Component Services DCOM configuration setting is not utilized or 
supported by FactoryTalk software or RSLinx Classic.
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About OPC DA communication 
As the distributed OPC DA server and client also use DCOM to communicate, 
the same issue might also appear. Do one of the following to resolve the issue: 

• The OPC DA interface for FactoryTalk Linx Gateway, FactoryTalk Live
Data, and RSLinx Classic must be configured to utilize the appropriate
DCOM authentication level to work with or without the Microsoft
patch (described earlier).

• Set the authentication level of third-party OPC DA server or client to
the same level as the Rockwell Automation applications.

• Lower the authentication level on computers that are installed with the
patch as mentioned above.

• Deploy the OPC DA server and client on the same computer.
• Change the communication method from OPC DA to OPC UA.

Set DCOM authentication level of KEPServer Enterprise 
When using KEPServer Enterprise, change the authentication level through 
the following: 

1. Open Component Services.
2. Double-click Console Root > Component Services > Computers > My

Computer > DCOM Config.
3. Right-click KEPServerEnterprise x.xx and select Properties.
4. On the General tab, select the authentication level in Authentication 

Level.
5. Click OK and restart KEPServer Enterprise.

Workgroup and domain settings after the applications’ authentication 
level is required to be updated 
After the applications authentication level is adjusted to 
RPC_C_AUTHN_LEVEL_PKT_INTEGRITY, ensure all users in your network 
that contains Rockwell Automation software and third party OPC DA meet the 
requirement of DCOM for RPC_C_AUTHN_LEVEL_PKT_INTEGRITY: 

• Each workstation in a workgroup or a domain must have the same
user accounts, with the same user names and passwords on each
machine, for all machines participating in a client-server environment.

For more information, see Microsoft documentation How to Configure a 
Domain User or Group. 

Start FactoryTalk Linx Gateway by selecting Start > Programs > Rockwell 
Software > FactoryTalk Linx Gateway > FactoryTalk Linx Gateway 

Configuration. (Or click on the FactoryTalk Administration Console 

Start FactoryTalk Linx 
Gateway 

https://docs.microsoft.com/en-us/microsoft-desktop-optimization-pack/medv-v1/how-to-configure-a-domain-user-or-groupmedvv2
https://docs.microsoft.com/en-us/microsoft-desktop-optimization-pack/medv-v1/how-to-configure-a-domain-user-or-groupmedvv2
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menu bar.) The FactoryTalk Linx Gateway Configuration dialog box opens. 
The default setting exposes all projects in the directory under the Network 
node. 

Tip: To start or stop the FactoryTalk Linx Gateway service, you must be either a Windows Administrator 
or Power User of the computer. 

The FactoryTalk Linx Gateway Configuration dialog box shows the Server 
Configuration, OPC UA Server Endpoints, software revision and activation 
information, and certificate and diagnostic information. 

Note: If there is a possibility that a remote client can start the FactoryTalk Linx Gateway service, you 
must disable the FactoryTalk Linx Gateway service via the Windows Control Panel (or all of the OPC 
clients should be stopped or shut down) before you reconfigure the scope. This will prevent the service 
from automatically starting while you are making changes to the scope configuration. The default DCOM 
settings prohibit launching the FactoryTalk Linx Gateway remotely and is the recommended setup. 

About the FactoryTalk Linx 
Gateway Configuration 
dialog box 
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The FactoryTalk Linx Gateway Configuration dialog box contains the 
following information: 

Item 
Description 
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Item 
Description 

The File button contains information about: 
• Log On 
• Log Off 
• Exit FactoryTalk Linx Gateway Configuration.
The Help button contains information about: 
• Release Notes. 
• Help Content 
• Software version number.
• Activation 
• Copyright 
• Contact information 
The Server Configuration tab contains information about: 
• FactoryTalk Directory scope selection. 
• OPC UA server name, status, OPC discovery service URL, status, and service inhibit checkbox.
• OPC DA server status and service inhibit checkbox.
The UA Server Endpoints tab contains information about: 
• OPC UA server name, port, and URL. 
• Security mode and policy. 
• Authentication settings.
• Diagnostic logging settings. 
The Advanced Settings tab contains information about: 
• OPC UA namespace index configuration.
• Create additional references for each array element in the OPC UA namespace.
The UA Tag List tab contains information about: 
• Set tag group, add tags to tag groups 
• Access of tags
• Data type in UA Tag List and OPC UA/DA Client 
The Certificate Management tab contains information about: 
• Incoming certificate import, reject, trust, and remove button.
• Outgoing certificate regenerate button.
• Certificate properties 
The FactoryTalk Diagnostic Log tab contains information about: 
• FactoryTalk Diagnostics information.
Click OK to apply the changes and restart FactoryTalk Linx Gateway service. 

Click Cancel to close the dialog box. 

Click Help to access the FactoryTalk Linx Gateway Help. 

Tip: The red boxes and text indicate the configuration is incomplete or invalid and requires changes to 
permit normal operation. 

Use Server Configuration to set FactoryTalk application scope and global 
server properties for the FactoryTalk Linx Gateway service. 

Global Settings 
Field Description 

Server Configuration 
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Field Description 

FactoryTalk Diagnostics Scope Sets the FactoryTalk Diagnostics path to an application. Tags from the selected application are made accessible to OPC 
clients through the UA or DA server. 
The supported scope will depend on the FactoryTalk Linx Gateway activation purchased. For more information on 
supported scopes and activation, see Activation types on page 76. 
Sets where the FactoryTalk Linx services reside, local to the FactoryTalk Linx Gateway host PC or distributed over the 
network. 

UA Server Settings 
Field Description 

Service Name Sets the OPC UA service name visible to OPC UA clients. 
Inhibit Inhibits or enables the OPC UA service. 

• Checked: Inhibits the OPC UA service from operating.
• Unchecked: Enables the OPC UA service. (default) 

Discovery service URL Lists the URL at which the OPC UA service can be accessed. 
Tip: Copy the URL text into the OPC UA client that accesses information from the FactoryTalk Linx Gateway OPC UA 
service. 

Register with Discovery Service Sets whether the OPC UA service is listed as part of the local OPC UA discovery service. 
Enable Tag List and Structure / Array Access Determines how the OPC UA service will present information to OPC UA Clients. 

• When disabled OPC UA Clients can access all data from all servers defined in a FactoryTalk application. Use this mode 
to provide compatibility with systems defined prior to version 6.21.00. 

• When enabled, OPC UA Clients will be limited to the items selected on the OPC UA Tag List tab. Use this setting to 
control which tags are accessible to specific OPC UA Clients and to access complex types using structures (Logix UDTs) 
and arrays.

DA Server Settings 
Field Description 

Inhibit Inhibits or enables the OPC DA service. 
• Checked: Inhibits the OPC DA service from operating.
• Unchecked: Enables the OPC DA service. (default) 
Tip: If the system only utilizes one of the OPC services, Rockwell Automation recommends inhibiting the other service to 
reduce the impact on the host computer and eliminate unwanted communications.

DA Access Changes the DA access after installation. This setting is only available when the current FactoryTalk Linx Gateway 
Configuration is relaunched as administrator. 
• Selects Only local DA clients to allow DA client and FactoryTalk Linx Gateway to operate on the same computer. 
• Selects Local or remote DA clients to allow DA client to operate on the same or on a remote computer. 

If this is selected, security risk might occur with higher DCOM privilege. 
Tip: This configuration will not be backed up. 

For more information about DCOM authorization level change, see 
Application authentication level for DCOM security on page 35. 

How do I open the Tag List window? 

1. On the Server Configuration page, select the Enable Tag List and 
Structure/Array Access checkbox under UA Server.

2. Click UA Tag List that shows on the left column.

UA Tag List 
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The UA tag list configuration determines the data values that each OPC UA 
Client can access from FactoryTalk Linx Gateway. The UA tag list option 
provides both enhanced security and complex type information (for example, 
structures and arrays). When the UA tag list option is disabled, all tags that 
are available from data sources in a FactoryTalk Application (for example, 
controllers and hardware via FactoryTalk Live, OPC DA and OPC UA servers) 
are accessible as scalar values to OPC UA Clients. The UA tag list contains one 
or more tag groups that define access rights and includes complex type 
information enabling an OPC UA Client to utilize structures or User Defined 
Types (UDT) from Logix controllers. 

Use UA Tag List to view and edit the tag group, add tags to the tag group and 
set tag access rights on page 44. 

FactoryTalk Linx Gateway provides the ability to create tag groups, which 
includes a subset of data tags in the FactoryTalk system and to add one tag to 
multiple tag groups. By configuring the tag group access rights with users, 
FactoryTalk Linx Gateway limits the OPC UA Client's access to this group of 
tags instead of exposing all the tags and manages accesses to different groups 
of clients. Users who are not given access to a tag group in FactoryTalk 
Security will have no access to the tags in the tag group. 

UA Tag List is also required if the OPC UA Client needs to access structured 
type information. 

Only the tags configured in the tag group can be added to namespace under 
the group folder. 

FactoryTalk Linx Gateway adds the OPC UA namespace based on the groups 
configured in UA Tag List. 

Use UA Tag List to add the following tags: 

• Structure and array and its elements separately. 

 
Note: If an element is added while the structure itself is not added, the structure will be added 
as a folder, and the rest elements under the structure will not be added automatically. 
If you add a structure or array in the UA Tag List, the exact structure or array will show in OPC 
UA Client. 

• Scalar. 
• Folder (for example, Shortcut to a Logix controller or program in a 

Logix controller and all its contents). OPC UA Client is able to find the 
tags under the folder in a real-time and dynamic way. When the tags in 
the Tag Browsed pane are changed, re-browse to find the updated 
tags. 

 
Tip: You need to add all the items you want to access individually to the tag list. 

 

 
Tip: The UA tag list does not support FactoryTalk Diagnostic Audit message. 
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Configure UA Tag List to add tags to groups, set access right on page 44 and 
user group of tags, export and import tags, and enable client to monitor and 
edit tags. 

Use the Export function to back up tags to a CSV file, which simplifies the 
operations of adding and editing multiple tags and tag groups. 

Use the Import function to import tags and tag groups in bulk. 

To add a tag group 

1. Click + next to Tag Groups
2. In the Tag Group Setting dialog box, define Name, Description,

Access Configuration, and Permission.

Tip: For multiple tag groups, by clicking Overview under Tag 
Groups, FactoryTalk Linx Gateway supports batch editing of 
access rights and tag groups. 

To add a tag to a tag group 
1. Click Add Tags.
2. Expand the left pane’s folder to locate a controller shortcut folder for

data items within a controller navigate in into the shortcuts Online 
Folder and select the item(s) you want to add in the Tag Browsed pane.

Tip: You can select multiple items simultaneously in the Tag Browsed pane. Selecting a 
shortcut or Logix program, structure or array  will result in all items associated within the 
selected item being included in the tag group. 

3. In the Tag Browsed pane, click + to select the tag and click Add.
Tip: The number of total items of all tag groups should be no more than 300,000 or error 
message will appear and cannot apply the configuration. Recommend adding array, structure or 
folder to avoid the large number of items. 

In the Add Tag window, the left side shows Folder and Structure. Array is 
listed in the right Tag Browsed pane. 

The Tag Browsed pane only displays two access rights, ReadOnly and 
ReadWrite. 

Tip: 
• The access right column displays the level of access provided by the Logix controller associated with 

the shortcut in the configuration. Utilize Studio 5000 Logix Designer to modify the controller’s tag 
settings. 

• If the tags or folders added in the UA tag list are invalid, the user should delete them or they will be 
shown in the Client with bad quality.

Use Refresh Namespace to sync namespace if namespace or projects in 
controllers are edited or updated. 

Set up and use UA Tag List 
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To refresh namespace 
• Click Refresh Namespace

Tip: When processing a namespace refresh operation, the UA tag list cannot be modified. 

To stop a namespace Refresh operation 
• At the bottom of the window, click Stop refreshing

After the namespace refresh is stopped, the user can configure the UA tag lists 
and then restart refreshing. 

When namespace refresh is finished, the UA tag list is refreshed and saved. 
Click OK or Apply to restart the service for the OPC UA Server to utilize the 
updated namespace. 

To improve security, set different accesses to each tag to different user 
groups. 

Tags can be configured to be accessed by all users or a specific FactoryTalk 
Security group. If tags are assigned to a FactoryTalk Security group, when an 
OPC Client connects, its user ID and password are checked against 
FactoryTalk Security. If a valid user ID is provided, the security groups for the 
user are verified with the Security Groups associated with each tag group.  If 
the user is in a security group authorized to access a tag group, the client is 
given access to the tags in the authorized tag groups. 

Access configuration in UA 
Tag List 
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To configure the tag group access 
On the Tag Group Setting pane, under Permission 

• Select All OPC UA client users can access. All users can access this tag
group.

Then under Access Configuration, select Tags in group limited to read 
only or Tags in group support read/write.

• Select Limit to selected FactoryTalk User Groups.

Only the users assigned to the certain user groups can access this tag
group. The tag access rights of the users under the selected user group
are defined in FactoryTalk Security.

Tip: At least one user group should be selected, otherwise all users will have access. 
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Tip: Multiple OPC UA Clients can be configured in the same FT Security group. A FactoryTalk Linx 
Gateway tag group can be assigned to multiple FactoryTalk Security groups. 
Multiple tags can be configured in a single FactoryTalk Linx Gateway tag group. The read/write access 
for tags is determined by the associated settings for the FactoryTalk Security group it is configured in. 
Tip: Multiple OPC UA Clients can be configured in the same FT Security group. An FactoryTalk Linx 
Gateway tag group can be assigned to multiple FactoryTalk Security groups. 
Multiple tags can be configured in a single FactoryTalk Linx Gateway tag group.The read/write access 
for tags is determined by the associated settings for the group it is configured in. 

The following table lists access configuration and results of tags when the UA 
tag list is enabled or disabled.  
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Desired access Server Configuration OPC UA “Enable 
Tag List” Setting 

OPC UA Server Endpoint 
“Authentication” setting 

Tag Group “Permission” setting 

All tags from all data 
servers can be 
accessed by all clients 

Disabled Anonymous N/A 

All tags from all servers 
can be accessed by 
authenticated clients 

Disabled FactoryTalk Security N/A 

A limited set of tags can 
be accessed by all 
clients 

Enabled FactoryTalk Security One or more tag groups with, “All OPC Client users 
can access” selected 

Each client can access 
a different set of tags 

Enabled FactoryTalk Security Multiple tag groups with “Limit to selected 
FactoryTalk User Groups” selected 

The following table describes how to configure the security options from the 
previous table.  

Access configuration location and how to locate Access configuration 
Tag Group Setting page 
Click the UA Tag List tab. 

Select Read only or Read and Write under Access 
Configuration. 
Select a user group that is allowed to access the tags: 
• All OPC UA client users can access 
• Limit to selected FactoryTalk User Groups 

Authentication Settings 
Click the UA Server Endpoints tab and find in the Endpoints 
Properties pane. 

Set access to users: 
• Anonymous 
If the OPC UA endpoint is configured to accept Anonymous 
users and the tag group access is set as Limit to selected
FactoryTalk User Groups on the Tag Group Setting pane, 
the Anonymous user should be added as a member of the 
selected FactoryTalk User Groups. 
Configure read and write access to CIA message in the UA 
Server Endpoints tab. 
• Authenticate with FactoryTalk Security 

FactoryTalk Administration Console 
Open FactoryTalk Administration Console and expand 
System>Polices>Product Policies>FactoryTalk Linx 
Gateway. Double-click Feature Security.  

Create a user in the desired FactoryTalk Security group for the 
OPC UA Client to use as its Login ID and Password. 
Set OPC UA Client Read and Write access to different user 
groups. See more in Authenticate an OPC UA client 

Controller The access set in the controller. 

IMPORTANT The final access right of a tag is determined by the intersection of all the access 
configuration results. 
If a tag is set as Read Only in the controller and Read and Write in Tag Group, OPC UA 
Client will quote the access as Read and Write set in the Tag Group. However, the tag's 
actual access in OPC UA Client is Read Only, so it's unable to write. 

Note: For Structure tag access right, if one element under the structure is set as Read Only, others are 
set as Read and Write, when clients try to write the structure, the element with the Read Only access 
fails to be written, while other elements are written successfully. 
If an offline tag .ACD file contains tags with access right set to be None in the controller, when adding the 
.ACD file in OPC UA Servers and adding its tags to a tag group in UA Tag List, the offline tags' actual 
access is not able to be browsed in Tag Browsed pane.  
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The data type shown in the UA Tag List and Tag Browsed pane uses the type 
names utilized by Logix5000 which is somewhat different from the names 
defined by OPC UA and DA. To clarify the map of the data type shown in 
different applications, the following table lists the corresponding data type 
relationship. 

UA Tag List OPC DA OPC UA 
BOOL VT_BOOL Boolean 
USINT VT_UI1 Byte 

SINT VT_I1 SByte 
INT VT_I2 Int16 
UINT VT_UI2 UInt16 
DINT VT_I4 Int32 
UDINT VT_UI4 UInt32 
LINT VT_I8 Int64 
ULINT VT_UI8 UInt64 
REAL VT_R4 Float 

LREAL VT_R8 Double 
STRING VT_BSTR String 

Use Select FactoryTalk Directory to select an application, area, or sub-area 
(also known as the scope) from the FactoryTalk Directory. Tags from the scope 
are presented to OPC UA and DA clients as node IDs for subscription. The 
top-level or root location in the FactoryTalk Directory tree is not a valid 
selection. 

• Tip: If the server scope is changed up or down a level in the FactoryTalk Directory tree, OPC clients 
may not be able to access tags from the original configuration. This is because the OPC browse 
interface provides node ID paths that are relative to the configured scope. After changing the scope, 
check all relative paths in client applications to determine if their values need to be updated. 

• You must inhibit the FactoryTalk Linx Gateway services before you can configure the scope. Note that 
if you do not have read permission, an error message opens when you configure scope. Refer to 
Secure FactoryTalk Linx Gateway using FactoryTalk Security on page 91. You must be logged into 
FactoryTalk to be able to configure the scope. If you have not already done so, you will be prompted 
to log in when you click Select.

Use UA Server Endpoints to add, remove, and configure OPC UA server 
endpoint URLs and properties.  

Each endpoint defines a specific approach for accessing data from the 
FactoryTalk Linx Gateway OPC UA service. With the security mode and policy 
set to "None", only one endpoint is required. Future extensions will add 
functionality where multiple endpoints may be desirable to limit tag access 
via specific security constraints. 

Data type in UA Tag List and 
OPC UA/DA Client 

Select FactoryTalk Directory 

UA Server Endpoints 
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UA Server Endpoints 
Field Description 

UA Server Endpoints A list of all configured OPC UA server endpoint URLs, their security modes, and security policies. 
Add Adds a new OPC UA server endpoint to the list. 
Remove Removes the highlighted OPC UA server endpoint from the list. 

Endpoint Properties 
Field Description 

Name Sets the name for the OPC UA server endpoint. The name must be unique. The server name displays in the OPC UA 
namespace and is included in the full tag path for all nodes provided by the server. 

Port Sets the port number for the OPC UA server endpoint. The port must be unique. The default port is 4990 and 
increments by 1 for each additional endpoint. 

URL Sets the network path to the OPC UA Server. The path must be in the format 
opc.tcp://hostname_or_ip:port/Endpoint/Name where 
hostname_or_ip, port, and /Endpoint/Name are replaced with the hostname or IP 
address, port number, and endpoint name of the OPC UA server. 
This URL must be provided to OPC UA client applications in order to connect to the FactoryTalk Linx Gateway UA 
service. 
The firewall on the FactoryTalk Linx Gateway OPC UA server must allow incoming connections to the selected port 
for the connection to succeed. 

Security Mode Displays the security method required for connections between OPC UA clients and the FactoryTalk Linx Gateway 
OPC UA server. 
• Sign: Use signature to secure the connection.
• Sign & Encrypt: Use signature and encryption to secure the connection.
• Sign + Sign & Encrypt: Use either signature or signature and encryption to secure the connection.

Security Policy Displays whether security is required or optional for connections between OPC UA clients and the FactoryTalk Linx 
Gateway OPC UA server. 
There are four security algorithm suites: 
• None 
• Basic128Rsa15 
• Basic256 
• Basic256Sha256 

Anonymous Sets OPC UA clients' log on user group is Anonymous with read and write access. 

Limit to read-only access Sets the log on user group is Anonymous with only read access. 
Enable read access to CIA message Permits an OPC UA client connected to FactoryTalk Linx Gateway with Anonymous login and read access 

permissions to retrieve information from a device using a FactoryTalk Linx shortcut configured with: CIP Object - 
Class/Instance/Attribute Message  

Enable write access to CIA message Permits an OPC UA client connected to FactoryTalk Linx Gateway with Anonymous login and write access 
permissions to send information to a device using a FactoryTalk Linx shortcut configured with: CIP Object - 
Class/Instance/Attribute Message  

FactoryTalk Security User Sets OPC UA clients' log on user group is FactoryTalk Security user with read and write access. The user is 
created in FactoryTalk Administration Console > System > Users and Groups. Username and password are 
needed. 

Log diagnostic message on tag write When enabled, FactoryTalk Linx Gateway will create a diagnostic or audit message every time a tag is written by 
an external OPC UA client. The default setting is disabled. 

Log as audit message When enabled, FactoryTalk Linx Gateway will create an audit message in the FactoryTalk Audit log with time-and 
date-stamped information to track changes that occurred during the operation of the system. 

Log as diagnostic message When enabled, FactoryTalk Linx Gateway will create a diagnostic message in the FactoryTalk Diagnostics log with 
time-and date-stamped information to help diagnose anomalies. 
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Use About FactoryTalk Linx Gateway to identify the version of the 
FactoryTalk Linx Gateway user interface, OPC UA and DA servers, and OPC 
Foundation Discovery Service, or to view the activation type and grace period 
status. 

To open About FTLinx Gateway: 
1. From the Windows Start Menu, select All Programs > FactoryTalk

Linx Gateway > FactoryTalk Linx Gateway Configuration.
2. Click Help > About FactoryTalk Linx Gateway.

Revision 
Field Description 

FactoryTalk Linx Gateway User Interface Revision Lists the version number of the FactoryTalk Linx Gateway user interface on 
the local machine. 

FactoryTalk Linx Gateway OPC UA Server Revision Lists the version number of the FactoryTalk Linx Gateway OPC UA service on 
the local machine. 

FactoryTalk Linx Gateway OPC DA Server Revision Lists the version number of the FactoryTalk Linx Gateway OPC DA service on 
the local machine. 

OPC Foundation Discovery Service Revision Lists the version number of the OPC Foundation Discovery Service on the 
local machine. 

Use Certificate Management to view FactoryTalk Linx Gateway OPC UA 
server certificate information. 

FactoryTalk Linx Gateway creates a default, self-signed security certificate 
during installation. The security certificate is stored at 
C:\ProgramData\Rockwell\FTLinxGateway\PKI\own\cert_ftgw_op
cua_server.der on the host computer for the FactoryTalk Linx Gateway
server. A custom security certificate can be created by generating a certificate 
signing request in FactoryTalk Linx Gateway and signed by an external 
trusted security authority and then imported to FactoryTalk Linx Gateway to 
replace the default certificate. 

Certificate properties 
Field Description 

Name Displays the name of the security certificate. 
Status Displays the certificate status, either Trusted or Rejected. 
Location Displays the path to the security certificate on the FactoryTalk Linx Gateway computer. 
Application Name Displays the application from where the certificate is presented. 
Organization Displays the organization name that submitted to CA when requesting the certificate. 
Application URI Displays the FactoryTalk Linx Gateway application URI associated with the security certificate. 
Domain Displays the workstation name. 

Subject Name Displays the subject properties on the certificate. For example, Common Name (CN). 
Valid From The date and time when the security certificate is valid. 
Expiration Time The date and time when the security certificate expires. 

About FactoryTalk Linx 
Gateway 

Certificate Management 
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Field Description 

Thumbprint A short sequence of bytes created by applying the cryptographic hash function to identify a certificate. 

Certificate actions 
Button Description 

Import Specifies and import the certificate to be used as incoming certificate or outgoing certificate. 

Reject Moves the specific certificate(s) from Trusted Certificates list to Rejected Certificates list. The client(s) cannot 
communicate with FactoryTalk Linx Gateway. 

Remove Removes the specific certificate(s) from Trusted Certificates list or Rejected Certificates list. The client(s) cannot 
communicate with FactoryTalk Linx Gateway. 

Trust The specific certificate is added to Trusted Certificates list and the client can communicate with FactoryTalk Linx Gateway. 
Create CSR Creates a Certificate Signing Request (CSR) and save the request as a CSR file. 
Regenerate Creates another certificate to renew the valid period. 
Refresh Refreshes to display the latest certificates. 
Manage Access Limits access to security certificate management operations to administrators or individuals approved by an administrator. 

This function is only available to Administrator. 
To add user or group: 
1. On Certificate Management tab, click Manage Access. 
2. In Manage Access dialog, click Add.
3. In Select User or Group dialog, click Advanced > Find Now.
4. In Search results, select the name of the user or group you want to add. 
5. Click OK. 
Tip: If you are Administrator and in the Administrator group but this option is still not available, do the following:
1. Launch Run.
2. Enter gpedit.msc and click OK.
3. In Local Group Policy Editor dialog, select Computer Configuration > Windows Settings > Security Settings > Local

Policies > Security Options. 
4. Double-click User Account Control: Run all administrators in Admin Approval Mode.
5. Select Disabled. 

How do I open Advanced Settings? 

1. From the Windows 10 Start menu, select Rockwell Software >
FactoryTalk Linx Gateway Configuration.

2. Select Advanced Settings.

Use Advanced Settings to configure advanced performance. 

Field Description 
Enable configuration of OPC UA namespace index Selects this checkbox to specify, refresh, delete, import or export OPC UA namespace index when tag list is turned 

on.  
For more details, see Enable configuration of OPC UA namespace index. 

Namespace index presented to OPC UA clients Sets user option to select FactoryTalk Linx Gateway OPC UA service namespace index value. An OPC UA Client will 
see (2 or 3). Default is 2. 

• When tag list is enabled, the UA client browsed the tag as namespace index = 2 or 3, 
with scalar/array/structure.

• When tag list is disabled, the UA client browsed the tag as namespace index = 2 or 3.

Create additional references for each array 
element in the OPC UA namespace 

When selected, FactoryTalk Linx Gateway will support OPC UA Clients to browse sub-elements under array. 
Tip: This option is only available when Enable Tag List and Structure/Array Access on the Server Configuration 
tab is selected. 

Advanced Settings 
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Use FactoryTalk Diagnostic Log to view historical error, warning, and 
information level diagnostic messages about the FactoryTalk Linx Gateway 
services on the current computer. 

FactoryTalk Diagnostic Log 
Button Description 

Refresh Clear the FactoryTalk Diagnostic Log and refresh diagnostic messages from the FactoryTalk Diagnostics server on the local 
computer. 

Launch FactoryTalk Diagnostic Viewer Starts the FactoryTalk Diagnostic Viewer to view diagnostic messages for all FactoryTalk devices and services, or to view 
diagnostic messages for a remote computer. 

FactoryTalk Diagnostic Log 
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Chapter 5 

Use FactoryTalk Linx Gateway to Access Data 

This chapter includes the following information: 

• Before you begin
• Starting FactoryTalk Linx Gateway
• Selecting the scope
• Accessing data

Before you can access data via FactoryTalk Linx Gateway, you must: 

1. Install and activate FactoryTalk Linx Gateway.

For the detailed steps, refer to Install FactoryTalk Linx Gateway on
page 17.

2. Create a FactoryTalk application, or point to an existing application, in
FactoryTalk Administration Console.

For the detailed steps, refer to FactoryTalk Services Platform Help.

3. Add a data server, for example, a FactoryTalk Linx data server.

For the detailed steps, refer to FactoryTalk Services Platform Help.

4. Add shortcuts to target controllers in FactoryTalk Linx.

For the detailed steps, refer to FactoryTalk Linx Online Help.

Start FactoryTalk Linx Gateway by selecting Start > Programs > Rockwell 
Software > FactoryTalk Linx Gateway > FactoryTalk Linx Gateway 

Configuration. (Or click  on the FactoryTalk Administration Console 
menu bar.) The FactoryTalk Linx Gateway Configuration dialog box opens. 
The default setting exposes all projects in the directory under the Network 
node. 

Tip: To start or stop the FactoryTalk Linx Gateway service, you must be either a Windows Administrator 
or Power User of the computer. 

The scope is the area or application from which you want to access data. The 
main FactoryTalk Linx Gateway Configuration dialog box shows the current 
scope. The supported scope will depend on the FactoryTalk Linx Gateway 
activation purchased. For more information on supported scopes and 
activation, see Activation types on page 76. 

A local scope means that only one instance of a FactoryTalk Linx data server 
can be configured, and resides on the local host computer. A network scope 
means that multiple FactoryTalk Linx data servers can be configured and may 

Before you begin 

Start FactoryTalk Linx 
Gateway 

Select the scope 
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be distributed across the network. If the FactoryTalk Linx Gateway is 
providing data to a FactoryTalk View SE application, activations that support 
the local or network application must be installed for FactoryTalk Linx 
Gateway and FactoryTalk View SE. 

• Tip: If there is a possibility of a remote or local client requesting tag data from FactoryTalk Linx 
Gateway, you must disable the FactoryTalk Linx Gateway service via the Windows Control Panel, or 
stop or shut down all of the OPC clients before you reconfigure the scope. This will prevent the service 
from automatically starting while you are configuring the scope. The default DCOM settings prohibit 
launching the FactoryTalk Linx Gateway OPC <DA> service remotely and is the recommended setup. 

• You must stop the service before you can configure the scope. Note that if you do not have read 
permission, an error message opens when you configure scope. Refer to the FactoryTalk Linx 
Gateway Help. You must be logged into FactoryTalk to be able to configure the scope. If you have not 
already done so, you will be prompted to log in when you click Select. 

• When using a new system, or if you need to change the scope, use the FactoryTalk Administration 
Console.

To select the scope: 
1. In Server Configuration, next to FactoryTalk Directory Scope, click

Select.
2. In Select FactoryTalk Directory, select either the Network or Local

FactoryTalk Directory.
3. From the FactoryTalk Directory tree, select an application or area.
4. Select OK.
5. In Server Configuration, select Apply.
6. In FactoryTalk Linx Gateway Configuration, click Yes to restart the

FactoryTalk Linx Gateway services and apply the scope change.

Your access to, and actions within, the FactoryTalk Linx Gateway tool are 
controlled by FactoryTalk Security settings. Refer to Secure FactoryTalk Linx 
Gateway using FactoryTalk Security on page 91 before attempting to configure 
FactoryTalk Linx Gateway. 

Once a FactoryTalk Directory scope has been selected and the FactoryTalk 
Linx Gateway service is running, OPC UA and DA clients can read and write 
the data provided from the FactoryTalk Linx Gateway services. Refer to your 
OPC client documentation for more information. 

Prerequisites: 
1. In the scoped FactoryTalk application, add a FactoryTalk Linx data

server.
2. In the scoped FactoryTalk application, create a shortcut from the

application to the server hosting the tag data.

      a. In FactoryTalk View Studio or FactoryTalk Administration  
Console, open Communication Setup.

b. In Device Shortcuts, click Add.

Access the data 
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c. (optional) Type a unique name for the shortcut. 

d. In the communications hierarchy tree in the right-hand pane, click 
the device that contains the tag data, then click Apply. 

e. Click Yes to apply changes. 

f. In Shortcut Type, select a type of shortcut. The default value is 
Processor. 

g. Click OK to close Communication Setup. 

For more information about shortcuts, see FactoryTalk Linx Help. 

3. (optional) On the FactoryTalk Linx Gateway host PC, use Server 
Configuration to verify the FactoryTalk Linx Gateway OPC UA or OPC 
DA service is running. 

To access data from FactoryTalk Linx Gateway: 
1. Start an OPC UA or DA client. 
2. Configure the OPC UA or DA client to connect to the FactoryTalk Linx 

Gateway service. 

• For OPC DA clients, this is done by entering or browsing to the 
hostname or IP address of the FactoryTalk Linx Gateway server. 

• For OPC UA clients, this is done by entering or browsing to an OPC 
UA Endpoint URL. If security is required, the client may need to 
accept the FactoryTalk Linx Gateway security certificate. 

3. In the OPC client, add a data group. 
4. In the OPC client, add one or more data items to the data group, up to 

but not exceeding the FactoryTalk Linx Gateway activation capacity. 

For more information on FactoryTalk Linx Gateway activations, see Activation 
types on page 76. 
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Chapter 6 

Use FactoryTalk Diagnostics Counter Monitor 
with FactoryTalk Linx Gateway 

This chapter includes the following information: 

• About FactoryTalk Diagnostics Counter Monitor
• Run FactoryTalk Diagnostics Counter Monitor
• Create a snapshot file
• Use FactoryTalk Diagnostics Counter Monitor to troubleshoot

FactoryTalk Linx Gateway

FactoryTalk Diagnostics Counter Monitor is installed with FactoryTalk 
Services Platform. This stand-alone tool shows diagnostic counter 
information as well as OPC clients, groups, and corresponding items. 

FactoryTalk Diagnostics Counter Monitor shows diagnostic information 
about the FactoryTalk Linx Gateway runtime operation: 

• Diagnostic counters are displayed as properties at the FactoryTalk Linx
Gateway, client, and group levels.

• Individual diagnostic items are displayed as children of their
corresponding group connection.

Tip: FactoryTalk Diagnostics Counter Monitor shows diagnostics for FactoryTalk Linx Gateway, 
FactoryTalk Live Data, and FactoryTalk Linx (if installed). 

About FactoryTalk 
Diagnostics Counter Monitor 
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The FactoryTalk Diagnostics Counter Monitor main window contains three 
areas: 

Item Description 

Navigator 
Workstations are manually added to or removed from a tree in the Navigator area. If FactoryTalk Linx or FactoryTalk Linx Gateway is installed on a 
workstation, FactoryTalk Diagnostics Counter Monitor automatically detects and shows them on the tree under the associated workstation. 
Data 
The values of the selected diagnostic items are displayed in the Data area. 
The Data area contains the following columns: 
• Name: At the root, provider, and client levels, this is the name of the diagnostic counter. At the group level, this is the tag name. 
• Value: At the root and provider levels, this is the returned data value of the diagnostic counter. At the group level, this indicates the status of the tag:

Active or Inactive. 
Note that neither the list of names nor their values can be modified. 
For a description of each counter, refer to the FactoryTalk Diagnostics Counter Monitor Help. 
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Item Description 

 
Viewer, which contains two tabs: 
• Troubleshooting Resources 

The Help is integrated into FactoryTalk Diagnostics Counter Monitor using this viewer. 
• FactoryTalk Diagnostics Messages 

Error messages associated with FactoryTalk Diagnostics Counter Monitor are logged to FactoryTalk Diagnostics. These messages are also displayed on 
the FactoryTalk Diagnostics Messages viewer. This enables you to see if there is any correlation between the logged messages and the values of the 
diagnostic items displayed in the Data area. Note that FactoryTalk Diagnostics messages are displayed for the local workstation only. 

To further aid in diagnosing problems, an integrated snapshot feature 
captures diagnostic values into an .xml file. This enables you to send this 
information to Rockwell Automation Technical Support if you need 
troubleshooting assistance. Refer to Create a snapshot file on page 60. 

 
Tip: FactoryTalk Diagnostics Counter Monitor is currently supported for desktop servers only. Windows 
CE is not supported in this release. 

Keep the following in mind while using FactoryTalk Diagnostics Counter 
Monitor: 

• Inactive tags are displayed with a value of Inactive. 
• If a group's state is inactive, then the items within that group are 

inactive, regardless of what appears on the screen. However, if a 
group's state is active, it does not affect the state of any items within 
that group; that is, items within that group may be active or inactive. 

• If client and group names are supplied by the client, then those names 
will be shown in the FactoryTalk Diagnostics Counter Monitor 
Navigator area. 

• Duplicate items are given a numerical suffix (that is, itemname (#)) to 
distinguish them and are treated as unique tags. Duplicate items are 
numbered sequentially as they are added, regardless of the Group to 
which they are added. For more information, refer to FactoryTalk 
Diagnostics Counter Monitor Help. 

Note the following before you begin using FactoryTalk Diagnostics Counter 
Monitor: 

• FactoryTalk Linx Gateway must be installed and running on one or 
more host computers on the network.  

• The diagnostics client must have access to a workstation that has an 
application with diagnostic items associated with it. A client must be 
accessing those diagnostic items in order for them to be shown on 
FactoryTalk Diagnostics Counter Monitor. 

• To prevent FactoryTalk Linx Gateway performance degradation, run 
only one instance of FactoryTalk Diagnostics Counter Monitor at a 
time, and close the tool when you have finished troubleshooting. 

To run FactoryTalk Diagnostics Counter Monitor: 
1. Start FactoryTalk Diagnostics Counter Monitor. 

Run FactoryTalk Diagnostics 
Counter Monitor 
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Click Start > Programs > Rockwell Software > FactoryTalk Tools> 
FactoryTalk Diagnostics Counter Monitor.  
The FactoryTalk Diagnostics Counter Monitor main window opens. By 
default, the Navigator area shows a single root item called System 
Diagnostics.  

2. Add a workstation to the Navigator area.

Right-click on the root in the Navigator area, and select Add 
Workstation. The Enter Workstation IP Address/Hostname dialog
box opens.

Tip: Alternately, you can add a workstation by clicking the root in the Navigator area and 
clicking . 

Enter the hostname or the device name of the workstation that 
contains the diagnostics you want to view, and click OK. For more 
information about the Enter Workstation IP Address/Hostname 
dialog box, refer to FactoryTalk Diagnostics Counter Monitor Help. 
Note that the default workstation is localhost. 

3. Expand the workstation to expose the installed data provider(s).
4. Click on any diagnostic item in the tree. The diagnostic counters

associated with the selected item are shown in the Data area of the
FactoryTalk Diagnostics Counter Monitor main window. While the
item is selected, the counter values are updated automatically as new
values are received.

Snapshot files aid in troubleshooting by capturing all diagnostic values in an 
.xml file, which can then be sent to Rockwell Automation Technical Support. 
The .xml file contains the values of all of the diagnostic counters, whether 
expanded and displayed or not. Refer to the FactoryTalk Diagnostics Counter 
Monitor Help for more information. 

To create a snapshot file: 
1. Click File > Save Snapshot.
2. Select the location to which you want to save the snapshot file. The

default location is the C: drive.
3. Enter a filename, or use the default filename, FTDiagData.xml.
4. Click Save.

To use FactoryTalk Diagnostics Counter Monitor to troubleshoot FactoryTalk 
Linx Gateway: 

1. Start FactoryTalk Linx Gateway. (Start > Programs > Rockwell 
Software > FactoryTalk Linx Gateway > FactoryTalk Linx Gateway

Configuration or click  on the FactoryTalk Administration
Console menu bar.)

Create a snapshot file 

Use FactoryTalk Diagnostics 
Counter Monitor to 
troubleshoot FactoryTalk 
Linx Gateway 
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2. Start FactoryTalk Diagnostics Counter Monitor. (Start > Programs >
Rockwell Software > FactoryTalk Tools > FactoryTalk Diagnostics 
Counter Monitor.)

3. Click FactoryTalk Linx Gateway OPC UA Server or FactoryTalk Linx 
Gateway OPC UA Server in the FactoryTalk Diagnostics Counter
Monitor Navigator area.

4. Use the counters displayed in the Counter area to see the high-level
status of the FactoryTalk Linx Gateway interactions with the clients:

• Activation: Verify the value indicates the correct activation.
• Count against Activation: Verify there are tags present (value > 0).
• Service Status: Verify the service is Running.
• Selected Scope: Verify the scope is correct for your application.
• Data Callbacks: Verify that tags are updating (values increase). If

tags are not updating, there are a number of possible reasons:

• The data values are static.
• The controller is in PROGRAM mode.
• Groups or items at the client level are inactive.

5. Click the FactoryTalk Diagnostics Messages tab in the Viewer area.
For more information about using this resource, refer to the
FactoryTalk Diagnostics Counter Monitor Help.

Back up and restore FactoryTalk Linx Gateway 
configuration 
Starting with version 6.30.00, the FactoryTalk Linx Gateway configurations 
can be backed up and restored in FactoryTalk Administration Console or by 
commands. It is important to create a backup of the system configuration 
after any significant changes are made, to help recover system operation if a 
computer hardware or operating system failure occur. 

The FactoryTalk Linx Gateway configuration is contained in Server 
configuration, UA Server Endpoint settings, Advanced Settings, and UA Tag 
List that must all be retained if you plan to restore the system later.  

• Back up FactoryTalk Linx Gateway configuration on page 61
• Restore FactoryTalk Linx Gateway configuration on page 63

FactoryTalk Services Platform provides an option to back up FactoryTalk Linx 
Gateway configuration configured on the same computer. You can back up 
the current settings and restore them later to control the settings, especially 
when the application or scope (Local or Network) of FactoryTalk Linx is 
changed. 

Back up FactoryTalk Linx 
Gateway configuration 
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The backup operation cannot include: 

• Incoming and outgoing certificates of FactoryTalk Linx Gateway 
• Trusted and rejected lists 
• DA Access option 
• The list of approved users that can manage certificates 

Refer to Restore FactoryTalk Linx Gateway configuration on page 63 to find 
steps to restore FactoryTalk Linx Gateway configuration on the local 
computer and distributed data servers. 

Prerequisites 
• Identify the security permissions needed to perform the backup 

operation. Backup is only available when you have the access in 
FactoryTalk Security (System > Policies > System Policies > User 
Rights Assignment > Backup and Restore). 

To back up FactoryTalk Linx Gateway configuration  
1. In FactoryTalk Administration Console Explorer, right-click the 

Network or Local, then select Backup. 
2. In Specify archive name, use the default name or a customized name 

for the backup file. 

 
Tip: We don't recommend changing the default archive name. The default name contains the 
leading digits of the security authority identifier which allows you to easily identify the archive 
file associated with a specific directory. 

3. In Specify archive location, use the default archive path or customize 
the path as needed. 

4. In Backup Contents: 

• Select FactoryTalk Linx Gateway configuration. 

 
Tip: This option is not available if the FactoryTalk Linx Gateway is not installed or the 
installed FactoryTalk Linx Gateway version is earlier than 6.30.00. 

• (optional) Select FactoryTalk Directory configuration to back up 
the entire FactoryTalk Directory. 

• (optional) Select FactoryTalk Linx configuration to back up the 
FactoryTalk Linx shortcut and driver configurations. 

5. To encrypt your archive file, select the Encrypt file contents checkbox, 
and then enter the same passphrase in the Passphrase and Confirm 
passphrase boxes. If you clear this check box, your backup archive file 
will not be encrypted or protected. 

Encrypt file contents is not available if your operating system does not 
support the proper level of encryption. 

6. Select OK. 
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The FactoryTalk Linx Gateway configuration can be restored when the 
configuration is backed up. This is helpful when a computer needs to be 
replaced or refreshed resulting from a significant hardware or operating 
system failure.  

Prerequisites 
• Identify the security permissions needed to perform the restore

operation. Restore is only available when you have the access in
FactoryTalk Security (System > Policies > System Policies > User
Rights Assignment > Backup and Restore).

To restore FactoryTalk Linx Gateway configuration 
1. In FactoryTalk Administration Console Explorer, right-click Network

or Local, and select Restore.
2. In Restore, select Browse, select the backup file (*.bak) to restore, and

select Open.
3. Select Next.
4. If the backup file is encrypted, Restore Backup File opens. Enter the

passphrase used during the backup operation.
5. In Restore Contents, select FactoryTalk Linx Gateway configuration

to restore configurations.
Tip:  This option is not available if the FactoryTalk Linx Gateway is not installed or the installed 
FactoryTalk Linx Gateway version is earlier than 6.30.00. 

6. Select Finish.

After restoring is completed, you should: 

1. (recommended) Restart computer.
2. Confirm that the FactoryTalk Directory scope is existing.
3. Refresh the URL in the UA Server Endpoints tab if the hostname of the

computer is changed.

4. Re-trust or re-reject the incoming certificates.
5. Regenerate or re-import the outgoing certificate.
6. (optional) Add users that can manage certificates.

FactoryTalk Linx Gateway supports backup and restore by commands. 

Parameter Required/Opti
onal 

Description 

Restore FactoryTalk Linx 
Gateway configuration 

Use commands to back up 
and restore 



Chapter 6 Use FactoryTalk Diagnostics Counter Monitor with FactoryTalk Linx Gateway 

64 Rockwell Automation Publication FTLG-GR001E-EN-E - March 2022 

Parameter Required/Opti
onal 

Description 

-s Required Specifies the FactoryTalk Directory scope. Only "Global" and "Local" scopes are 
supported. 

-sso Required Uses single sign-on for authentication. 
-b Required Command for backup, which is conflict with the -r command. 
-r Required Command for restore, which is conflict with the -b command. 
-bak Required Specifies the location to save the backup file or the location where restore file 

can be found. (For example: -bak c:\aa.bak) 
• For backup operation, the existing files will be replaced while creating new 

files. 
• For restore operation, make sure the file already exists in the system. 

-ftd Optional The whole FactoryTalk directory. The -sys and -app commands will be ignored 
if the -ftd is used. 

-sys Optional The FactoryTalk System directory. 

-app Optional Specifies the FactoryTalk application. Specific application names are needed 
when using this parameter. 

-ido Optional Used to restore the FactoryTalk Directory identifier. It's only valid with 
command -r. 

-prod Optional Specifies the product names. (For example: -prod "FactoryTalk Linx Gateway") 
-e Optional Used to encrypt the backup file. 
-pp Optional The plain passphrase is used to encrypt or decrypt the backup file. The 

command will be ignored when "-ep" command  is used or the "-e" command 
is not used. 
Note: If the passphrase contains a ", it should be type as "" in command
line. For example, if the passphrase is 
~!@#$%^&*()_+-={}[]|\:";'<>,.?/, when you use 
the passphrase to encrypt or decrypt the backup file in commands, you should 
type the passphrase as 
"~!@#$%^&*()_+-={}[]|\:"";'<>,.?/". 

-f Optional Used to force replace the opened applications if needed. 
-ow Optional Used to overwrite the existing applications. 

Examples of using the command line: 
• Back up the FactoryTalk Linx Gateway

"C:\Program Files (x86)\Common
Files\Rockwell\FTSysBackupRestoreTool.exe" -b -s
Global -sso -bak C:\backup\FTLGW_File.bak -prod
"FactoryTalk Linx Gateway"

• Back up the the FactoryTalk Directory and FactoryTalk Linx
"C:\Program Files (x86)\Common
Files\Rockwell\FTSysBackupRestoreTool.exe" -b -s
Global -sso -bak
C:\Users\Administrator\Desktop\identifier.bak -ido
"C:\Program Files (x86)\Common
Files\Rockwell\FTSysBackupRestoreTool.exe -b -s Global
-sso -bak c:\backup\FTLGW_File.bak -prod “FactoryTalk
Linx”

• Restore the FactoryTalk Linx Gateway
"C:\Program Files (x86)\Common 
Files\Rockwell\FTSysBackupRestoreTool.exe -r -s 
Global -sso -bak C:\backup\FTLGW_File.bak -prod 
"FactoryTalk Linx Gateway" 

Restore the FactoryTalk Directory and FactoryTalk Linx 
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"C:\Program Files (x86)\Common 
Files\Rockwell\FTSysBackupRestoreTool.exe" -r -s 
Global -sso -bak 
C:\Users\Administrator\Desktop\identifier.bak -ido 
"C:\Program Files (x86)\Common 
Files\Rockwell\FTSysBackupRestoreTool.exe -r -s Global 
-sso -bak c:\backup\FTLGW_File.bak -prod “FactoryTalk
Linx” 

Note: For an encrypted bak file created in FactoryTalk Services Platform version 3.00 and
before, if no passphrase was entered, the restore commands should be like: 
"C:\Program Files (x86)\Common 
Files\Rockwell\FTSysBackupRestoreTool.exe" -r 
-s Global -sso -bak
C:\Users\Administrator\Desktop\Network.bak -ftd
-e
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Chapter 7 

Troubleshoot FactoryTalk Linx Gateway 

This chapter includes the following information: 

• What to check first if you’re having problems
• Troubleshooting tools for FactoryTalk Linx Gateway
• Troubleshooting topics
• How to contact technical support

Does your FactoryTalk Linx Gateway meet the minimum hardware and 
software requirements? Refer to Install FactoryTalk Linx Gateway on page 17 
for these requirements. 

Is the software installed correctly? Refer to Install FactoryTalk Linx Gateway 
on page 17 for installation instructions. Restart your computer after installing 
the software before you begin using FactoryTalk Linx Gateway. 

Do you have a valid activation file? Check the FactoryTalk Diagnostics log. An 
information message is logged if the activation file is not detected by the 
system when you launch FactoryTalk Linx Gateway. Refer to the FactoryTalk 
Services Platform Help for information about FactoryTalk Diagnostics 
messages. Refer to About Activations on page 75 for information about 
activations. 

Is the OPC UA client successfully connected to the FactoryTalk Linx Gateway 
server? Check if the OPC UA client use the same security mode and policy 
with FactoryTalk Linx Gateway. For example, Sign & Encrypt and 
Basic256Sha256. Make sure the OPC UA client trust the FactoryTalk Linx 
Gateway certificate: cert_ftgw_opcua_server.der. Refer FactoryTalk
Linx Gateway Online Help for information about secure OPC UA client and 
certificate validation. Also confirm both the OPC Client and the FactoryTalk 
Linx Gateway have trusted each other’s security certificates. There could be a 
case where the two connect properly but no data is available. This can happen 
if the user chooses tag list but does not configure any tags. Another case could 
occur when the client successfully connects and is able to browse tags but is 
not able to read or write.  This could be because the security is not 
configured or the client is not using the correct ID/Password credentials. 

To help you isolate, diagnose, and correct any problems you may experience 
using FactoryTalk Linx Gateway, use the following troubleshooting tools: 

Use the FactoryTalk Linx Gateway Configuration Tool to view status and 
diagnostic information. Server Configuration displays the server status. 
About > FactoryTalk Historical Diagnostics displays FactoryTalk Diagnostics 
messages scoped to the FactoryTalk Linx Gateway service. 

What to check first if 
difficulties are experienced 

Troubleshooting Tools 

FactoryTalk Linx Gateway 
Configuration Tool 
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FactoryTalk Diagnostics provides the ability to log errors, warnings, and other 
status messages generated throughout a FactoryTalk-enabled system to a 
central location called an event log. If you encounter a problem, you can 
review the events in the log that led up to the problem to assist in determining 
the cause. Or, you can monitor the log to identify potential problems and take 
corrective action before a problem occurs. 

Note that FactoryTalk Diagnostics messages are displayed for the local 
workstation only. 

Refer to the FactoryTalk Services Platform Help for more information about 
FactoryTalk Diagnostics and the event log. Refer to the FactoryTalk Linx 
Gateway Help for more information about diagnostic messages specific to 
FactoryTalk Linx Gateway. 

FactoryTalk Diagnostics Counter Monitor aids in troubleshooting OPC 
connections from third-party products. It shows diagnostic information 
about the FactoryTalk Linx Gateway runtime operation. The FactoryTalk 
Diagnostics event log and Help are integrated into this tool. Refer to Use 
FactoryTalk Diagnostics Counter Monitor with FactoryTalk Linx Gateway on 
page 57 for more information. Refer to the FactoryTalk Diagnostics Counter 
Monitor Help for individual counter descriptions. 

FactoryTalk Live Data Test Client is a utility to test your OPC DA connection 
after you have configured the FactoryTalk Linx Gateway. This utility is 
installed automatically with FactoryTalk Services Platform. This utility can 
only test connections to the FactoryTalk Linx Gateway OPC DA service. While 
this test client is not able to interface with the FactoryTalk Linx Gateway OPC 
interface, it can be used to verify if FactoryTalk Linx is able to access the 
desired data.   

OPC Test Client is a utility that enables you to test your data connections if 
you are using remote OPC Client functionality. This utility is installed 
automatically as part of Remote FactoryTalk Linx Gateway on the FactoryTalk 
Linx Gateway product DVD. 

The OPC Foundation provides an OPC UA sample client, available for 
download at 
https://opcfoundation.org/developer-tools/samples-and-tools-unified-archite
cture/net-stack-and-sample-applications/. 

The topics below provide information to help you troubleshoot FactoryTalk 
Linx Gateway. 

Possible causes and solutions 

• FactoryTalk Linx Gateway is not configured

a. No scope

To solve this issue, configure the related scope based on the 
activation type and apply the system configuration. 

FactoryTalk Diagnostics 

FactoryTalk Diagnostics 
Counter Monitor 

FactoryTalk Live Data Test 
Client 

OPC Test Client 

Troubleshooting topics 

FactoryTalk Linx Gateway's 
OPC UA service does not 
appear in the OPC Local 
Discovery Service (LDS) 

https://opcfoundation.org/developer-tools/samples-and-tools-unified-architecture/net-stack-and-sample-applications/
https://opcfoundation.org/developer-tools/samples-and-tools-unified-architecture/net-stack-and-sample-applications/
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b. OPC UA is disabled

To solve this issue, enable the OPC UA server in the Server 
Configuration tab. 

c. No endpoint configured

To solve this issue, configure the endpoint URL in the UA Server 
Endpoints tab and apply the system configurations. 

d. An endpoint is inhibited

To solve this issue, enable the endpoint. 

• FactoryTalk Linx Gateway OPC UA service is not started

To solve this issue, start the OPC UA service from Control 
Panel>System and Security>Administrative Tools>Services> 
FactoryTalk Linx Gateway OPC UA Server.

• FactoryTalk Linx Gateway OPC UA service is inhibited

To solve this issue, enable the OPC UA server in the Server 
Configuration tab.

• FactoryTalk Linx Gateway is not activated correctly or activation is
expired

To solve this issue, get a new key from Rockwell Automation.

• The option to register with the LDS is disabled

To solve this issue, select Register with Discovery Service in the Server 
Configuration tab.

• FactoryTalk Linx Gateway has not trusted the OPC LDS certificate

To solve this issue, click Trust in the Certificate Management tab to
add the LDS certificate into the trust list.

• The OPC LDS certificate has expired

To solve this issue, stop the service and delete its certificate from the
hard drive. Once the service starts it will automatically regenerate the
certificate.

• OPC Local Discovery Service (LDS) service is not started

To solve this issue, start the LDS service from Control Panel>System 
and Security>Administrative Tools>Services>OPC UA Local Discovery
Server

If you are experiencing activation problems, refer to: 

• About Activations on page 75
• FactoryTalk Linx Gateway troubleshooting topics in FactoryTalk Linx

Gateway Help.
• FactoryTalk Activation Manager troubleshooting topics in FactoryTalk

Activation Manager Help.

If you are experiencing problems with FactoryTalk Security, refer to: 

FactoryTalk Linx Gateway 
activations 

FactoryTalk Security 
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• Secure FactoryTalk Linx Gateway using FactoryTalk Security on page
91 

• Troubleshooting topics in FactoryTalk Services Platform Help.

If you are experiencing problems starting or stopping the FactoryTalk Linx 
Gateway service, verify your Windows user account privileges. You must have 
administrative rights to start and stop the service. 

If you are experiencing problems with bad quality data, no data being 
returned, data is stale or frozen, or tags do not appear during an OPC client 
tag browse operation, use the following steps to isolate and correct the 
problem: 

1. If testing an OPC DA connection, verify that the FactoryTalk
connection is working.

a. If testing an OPC DA connection, use the FactoryTalk Live Data Test
Client to connect directly to FactoryTalk (not FactoryTalk Linx
Gateway). Then, verify that you can browse and add an item. If there
are no problems, then the issue is with FactoryTalk Linx Gateway, not
FactoryTalk.

2. Test the connection.

a. If testing an OPC DA connection, run OPC Test Client or FactoryTalk 
Live Data Test Client. Note that you may need to change the DCOM 
settings if you use OPC Test Client.

a. Navigate to the application containing the data server that you 
are trying to use.

b. Browse, and put some tags on scan. If you cannot browse for 
tags, then the data server is not configured correctly or the 
devices that the data server is pointing to are not configured or 
connected.

    b. If testing an OPC UA connection, use the OPC Foundation UA Sample   
Client to connect to FactoryTalk Linx Gateway. If the sample client 
connects, the issue is not with FactoryTalk Linx Gateway but with the OPC 
UA client.

3. Verify that the tags are not hidden by the External Access attribute (set
in Logix Designer, starting with version 18 for controllers that support
External Access). For more information on the External Access
attribute, refer to the documentation for version 18 (CPR 9 SR 2) or
later of the application. Note that if the External Access attribute for a
tag in a controller is changed from None to Read or Read/Write, you
may need to restart the data client to see the tag. If the External Access
attribute for a tag in a controller is changed from Read or Read/Write
to None, the Quality changes to Out of Service for that tag.

4. Check the FactoryTalk Linx Gateway configuration.

a. Open FactoryTalk Linx Gateway

Rockwell Automation Publication FTLG-GR001E-EN-E - March 2022 
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b. Verify that the server is running. If you are experiencing stale or
frozen data, it is possible that the client was not notified that
FactoryTalk Linx Gateway service had stopped.

c. Verify that the proper application, including scope (network or
local), is selected.

d. Verify that you have the correct activation for the application you
are trying to run.

5. Check the FactoryTalk Diagnostics log. Some events to check for:

a. A controller is in the process of downloading a new program. The 
FactoryTalk Diagnostics log will indicate if a new program has 
been downloaded and specify the path.

b. The activation is incorrect for the application or you have 
exceeded the activation capacity.

c. The tag does not exist. Any currently non-existing tags should be 
logged as not existing in the controller.

6.   Check the FactoryTalk Linx configuration.
a. Open FactoryTalk Administration Console or FactoryTalk View 

Studio.
b. Right-click the FactoryTalk Linx server and select Properties. 

Verify the correct computer hosting FactoryTalk Linx is shown.
c. Double-click Communication Setup.

d. Verify that there is a shortcut configured and that it has the correct 
name.

e. Click the shortcut and verify that it is pointing to the expected 
device within the communication tree.

f. SS6. Right-click the network you are using and select Start 
Browsing. If the device disappears from the Communication tree, 
then FactoryTalk Linx is no longer finding the device. Verify that 
the device is online.

7.   If testing an OPC DA quality issue, verify that DCOM access settings 
are configured correctly.
8.   Verify any firewall software is configured to allow access to 
FactoryTalk Linx Gateway OPC DA and UA service ports.
9.   Verify that the scope and FactoryTalk Linx shortcuts are correctly 
configured. Refer to Access the data on page 54.

If the above steps do not resolve your problem, please contact Rockwell 
Automation Technical Support. 

There are many factors to consider when diagnosing communication 
problems: 

• Computer effect on communication

Communication slow or 
unreliable 
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• Memory, disk space, and anti-virus scans can affect computer 
performance. Refer to System requirements on page 17. 

• Firewalls and switches can completely or partially block 
communication. 

• The typical timing factor for communication updates is the CPU 
load. Rockwell Automation recommends a 40% maximum steady 
state CPU loading. This balances utilization of the hardware and 
gives enough bandwidth for peak loading. 

• Multiple clients effect on communication 

• The packaging of data to OPC standards takes computer CPU power 
to achieve, and this can be significant depending on the data 
loading. 

• The number of clients requesting data from a single OPC data 
server can also significantly impact computer CPU loading, 
particularly if they are not requesting the same items (tags). 

• Clients creating and destroying groups can significantly impact 
CPU usage. 

• Network effect on communication 

• An incorrect network configuration can reduce communication 
effectiveness. Verify your network configuration as well as your 
installation. Refer to Install FactoryTalk Linx Gateway on page 17. 

• Controller effect on communication 

• For ControlLogix controllers, data requests are handled by a CPU 
separate from the control program CPU. (FlexLogix controllers have 
one CPU to handle all tasks.) However, eventually these data 
requests are handled by the controller program. This affects 
communication efficiency since the controller is performing higher 
priority tasks and handles communication when CPU time is 
available. You can monitor task utilization using Logix 5000 Task 
Monitor on the Logix Designer utilities DVD. 

• Data requests are sent to controllers via a network port (for 
example, Ethernet, ControlNet, DeviceNet). For ControlLogix 
Ethernet communication, the ENET, ENBT, EN2T, or EWEB 
module is required. These modules could be a bottleneck to 
communication depending on the number of data requests and the 
number of requesting clients. 

• Tag structure in a controller program can also have a significant 
impact on communication efficiency. Refer to your Logix Designer 
documentation. 

• The communication time slice setting within the controller (set 
using Logix Designer application) will affect communication. You 
may need to increase the setting value. 

• The way OPC clients request data can either help or hinder the 
ControlLogix Optimized Packets process. Refer to your 
ControlLogix controller documentation. 
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• Offline or disconnected controllers will cause additional retries and 
diagnostics to be logged. Inhibit a controller using FactoryTalk Linx 
if it will not be present in the system for an extended period of time. 

• DCOM effect on communication 

OPC DA is based on DCOM, therefore: 

• Changing DCOM security settings may stop the OPC DA service 
from working. 

• Changing DCOM security settings may prevent a client from 
browsing tags through the OPC UA service. 

• If the server and client become disconnected (either via a physical 
network disconnect or a software disconnect), there is a hard-coded 
6-minute time-out notification. 

• If the server and client are reconnected, the OPC connection is not 
automatically reconnected to the original objects. Therefore, servers 
and clients may require restarting. 

• In response to Microsoft Distributed Component Object Model 
(DCOM) Hardening patch (MS KB5004442), the minimum DCOM 
authentication level used has been raised to Packet Integrity. 

• Both OPC DA clients and servers must have the same DCOM 
authentication level. 

If you are experiencing a problem with, or have a question about FactoryTalk 
Linx Gateway, please consult the Help and Release Notes. If you cannot find 
the answer, contact Rockwell Automation Technical Support. 

440-646-3434 

http://www.rockwellsoftware.com 

http://support.rockwellautomation.com 

Support staff are available 8 a.m. to 5 p.m. EST, Monday through Friday, 
except holidays. 

Before you call, you should be at your computer and be prepared to give the 
following information: 

• The product serial number and version number. These can be found by 
clicking Start > Settings > Control Panel > Add/Remove Programs and 
clicking FactoryTalk Linx Gateway. 

• The type of hardware you are using. 
• The version of Windows operating system you are using. 
• The exact wording of any messages that appeared on your screen. 
• What happened and what you were doing when the problem occurred. 
• How you tried to solve the problem. 

 

Contact Rockwell 
Automation Technical 
Support 
Phone 
Worldwide web 

Hours of operation 

Before you call 
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Appendix A 

About Activations 

Rockwell Automation Windows-based software products are copy protected 
and require an activation key, located in an activation file, to run the software. 

When you launch FactoryTalk Linx Gateway, the software checks for the 
activation file. If a valid activation cannot be found, an error is logged to 
FactoryTalk Diagnostics and FactoryTalk Linx Gateway operates under a grace 
period. Refer to FactoryTalk Services Platform Help for more information 
about grace periods. 

This appendix includes the following information: 

• Activate FactoryTalk Linx Gateway 
• Activation types 

FactoryTalk Linx Gateway supports activating software during the software 
installation. The new Installation Setup Wizard contains an Software 
Activation check box. This no longer requires you to open FactoryTalk 
Activation Manager to activate the software. 

To activate your copy of FactoryTalk Linx Gateway in the FactoryTalk Linx 
Gateway Installation Setup Wizard, perform the following steps: 

1. Perform the steps in Install FactoryTalk Linx Gateway on page 17 to 
install FactoryTalk Linx Gateway software. 

2. On the Rockwell Software Setup dialog box in the Installation Setup 
Wizard, select the Activate your software check box and click Finish. 

3. On the Software Activation dialog box, enter the product key from 
your Activation Certificate. The serial number should have been 
automatically added. If the serial number is not automatically added, 
enter the serial number. 

4. Select Activate locally to activate FactoryTalk Linx Gateway on a single 
computer, or select Activate using a dongle to activate FactoryTalk 
Linx Gateway on any computer by using a dongle. 

 
Tip: The Activate using a dongle option requires that you have a dongle to lock the activation. 

5. Click Continue. 

You can still activate FactoryTalk Linx Gateway via FactoryTalk Activation 
Manager by clicking the Explore other options link in the Software Activation 
dialog box. The link provides direct access to the FactoryTalk Activation 
Manager software. To activate your copy of FactoryTalk Linx Gateway in the 
FactoryTalk Activation Manager, click Get New Activations and follow the 
instructions in the FactoryTalk Activation Manager. 

Activate FactoryTalk Linx 
Gateway 
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For more information on using the FactoryTalk Activation Manager, click 
More or Help in the FactoryTalk Activation Manager. 

EvRSI activation is replaced by FactoryTalk Activation Manager. If you are 
using EvRSI activation, please contact your local Rockwell Automation Sales 
office or Technical Support for information on migrating your activations to 
FactoryTalk Activation Manager. 

For Rockwell Automation Technical Support in the U.S., call (440) 646-3434. 

Outside the U.S., visit http://www.rockwellautomation.com/locations. 

The activation type determines feature support and the maximum capacity of 
unique tags that can be added to the FactoryTalk Linx Gateway server. The tag 
limit is for all unique tags, including active, inactive, and valid tags. However, 
the OPC DA service and UA service tag limits are separate; a 5,000 tag limit 
activation can simultaneously serve 5,000 tags to DA clients and 5,000 tags to 
UA clients. All FactoryTalk Linx Gateway activations support a client capacity 
of up to 20 simultaneous OPC DA or 110 OPC UA client connections (the 
suggested connection quantity is 20 based on the previous testing). But the 
actual capacity for OPC client connections could vary based on available 
computer resources and the amount of information being requested. 

If a valid activation cannot be found, FactoryTalk Linx Gateway operates 
under a grace period. The maximum capacity of tags supported is 500,000. 

Beginning with version 6.20, the FactoryTalk Linx Gateway Basic and 
Standard activations can operate with a FactoryTalk View SE station or 
distributed application using a network directory when there is a single 
FactoryTalk Linx data server operating on the same workstation FactoryTalk 
Linx Gateway is installed on. Version 6.21 added the Extended activation with 
the same local and network/station capability. A patch is also available to 
support a similar operation and Extended activation for FactoryTalk Linx 
Gateway version 6.00 to version 6.20 and for FactoryTalk Gateway version 3.74 
to version 3.90. 

A FactoryTalk application directories can be configured as Local or Network. 
These options are determined by the capabilities defined by the 
license/activation that is being used. 

1. Local - Small application where the FactoryTalk Linx or FactoryTalk 
Linx OPC UA Connector communications service is operated on the 
same workstation as FactoryTalk Linx Gateway. A local application is 
configured with a single level where all communications services are 
defined at the same top level (no areas are supported). 

 
Note: Grace period is a seven-day free trial of FactoryTalk Linx Gateway during which, a user 
has the tag subscription capability equals to the "Professional" activation. When the grace 
period is over, the OPC UA/DA clients cannot connect to the FactoryTalk Linx Gateway. 

2. Network -This configuration uses the Network directory. A network 
station application permits areas to be created to improve the 
organization of the application (This type of configuration can be used 

Activation types 
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with software like FactoryTalk View SE Station or FactoryTalk 
Historian which does not support Local directory). There are two 
categories designed for Network directory. 

• Station - Data servers (FactoryTalk Linx and FactoryTalk Linx UA 
Connector) must be on the same workstation as FactoryTalk Linx 
Gateway. When operating on a compute module, the data servers 
must be in the same module and cannot be remote.  

• Distributed - This type of directory permits communications 
services to be located on multiple/different workstations from 
FactoryTalk Linx Gateway. Up to ten (10) of each type of 
communications services (FactoryTalk Linx and FactoryTalk Linx 
OPC UA Connector) can be defined in a system. These 
communications services can be configured as redundant to 
support high availability configurations (This type of configuration 
can be used with software like FactoryTalk View SE Distributed). 

When checking for valid activations, FactoryTalk Linx Gateway finds and uses 
the activation with the highest feature support. The selected activation type is 
visible in the About tab of FactoryTalk Linx Gateway Configuration. 

From FactoryTalk Linx Gateway version 6.00.00, only the four new activations 
(FactoryTalk Linx Gateway Professional, FactoryTalk Linx Gateway 
Distributed, FactoryTalk Linx Gateway Standard, and FactoryTalk Linx 
Gateway Basic) are available for new users. From FactoryTalk Linx Gateway 
version 6.21.00, only the three new activations (FactoryTalk Linx Gateway 
Extended, FactoryTalk Linx Gateway Embedded, and FactoryTalk Linx Data 
Bridge Embedded) are available for new users. However, the other legacy 
activations used in previous versions of the product are still supported. All the 
activations are shown in the table below from top to bottom as highest to 
lowest priority. 

Activation Name Activation Tag 
Limit 

FactoryTalk Directory Distributed 
Network 

Activates FactoryTalk 
Linx Data Bridge 

FactoryTalk Linx Gateway Professional LINXGW.PROFESSIONAL 500,000* Local or Network  Y Y 

FactoryTalk Gateway Distributed RSOPCD.UNLTD 500,000* Local or Network  Y N 

FactoryTalk Gateway Distributed 70K RSOPCD.70000 70,000 Local or Network  Y N 

FactoryTalk Linx Gateway Distributed LINXGW.DISTRIBUTED 32,000 Local or Network  Y N 

FactoryTalk Gateway Distributed 32000 RSOPCD.32000 32,000 Local or Network  Y N 

FactoryTalk Gateway Station 32000 RSOPCS.32000 32,000 Local N N 
FactoryTalk Linx Gateway Extended LINXGW.EXTENDED 500 Local or Network  N Y 
FactoryTalk Gateway Distributed 5000 RSOPCD.5000 5,000 Local or Network  Y N 
FactoryTalk Linx Gateway Standard LINXGW.STANDARD 5,000 Local or Network  N N 
FactoryTalk Gateway Station 5000 RSOPCS.5000 5,000 Local N N 
FactoryTalk Gateway Distributed 1500 RSOPCD.1500 1,500 Local or Network  Y N 
FactoryTalk Gateway Station 1500 RSOPCS.1500 1,500 Local N N 
FactoryTalk Linx Gateway Basic LINXGW.BASIC 1,000 Local or Network  N N 
FactoryTalk Linx Gateway Embedded Verifies its operating on 

a CompactLogix 5480 
windows core 

500 Local or Network  N N 
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Activation Name Activation Tag 
Limit 

FactoryTalk Directory Distributed 
Network 

Activates FactoryTalk 
Linx Data Bridge 

FactoryTalk Linx Data Bridge Embedded Verifies its operating on 
a CompactLogix 5480 
windows core 

500 Local or Network  N Y 

FactoryTalk Linx Data Bridge Standard LINXDB.STANDARD 2000 Local or Network  N Y 
Gold Master GOLDMASTER 500,000* Local or Network Y Y 

If a system requires 32,000 or more tags, use a 500,000* activation and refer to 
the FactoryTalk Linx Gateway Release Notes > Application Notes for tested 
hardware and update rates. 

500,000* : Default tag limit. You can edit it in the FactoryTalk Administration 
Console (System > Policies > FactoryTalk Linx Gateway > FactoryTalk Linx 
Gateway Policy > Tag count limitation for professional activation). 

 
Tip: To check the number of tags added to FactoryTalk Linx Gateway, use FactoryTalk Diagnostics 
Counter Monitor. 
• For OPC DA service tags, view the Count against Activation counter. 
• For OPC UA service tags, view the Total Items in Subscription counter. 
If you have multiple clients subscribing the same tags, the tags being used against the activation limit 
should be counted separately. For example, there are five clients subscribing to 1000 tags, then the total 
activation limit used is 5000 tags. 

As a best practice, Rockwell Automation recommends using a shared 
concurrent activation, which is locked to a networked activation server 
computer, but shared by client computers on the network. Refer to 
FactoryTalk Services Platform Help for more information. 

Note that if you have multiple FactoryTalk Linx Gateway instances using 
different tag counts, each FactoryTalk Linx Gateway instance must be 
activated using its own specific activation file to ensure that each FactoryTalk 
Linx Gateway instance receives the correct tag count activation. 

 
Tip: FactoryTalk Batch v9.00.00 (CPR 9) and later supports direct communication between FactoryTalk 
Live Data and plant-floor controllers and devices, removing the need for FactoryTalk Linx Gateway. 
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Appendix B 

Install FactoryTalk Linx Gateway with command 
line syntax 

Besides the Setup Wizard installation, FactoryTalk Linx Gateway also 
supports automated installation using command line syntaxes: unattended 
installation. You can typically use the unattended installation during 
large-scale rollouts when it might be too slow and costly to have 
administrators or technicians interactively install the FactoryTalk Linx 
Gateway software on individual computers.  

In the unattended installation, you enter a specified command line with 
multiple parameters. During the installation process, instead of prompting 
you for installation and configuration information interactively, the process 
follows the parameters you specified in the command lines.  

To install FactoryTalk Linx Gateway in the unattended mode, follow the steps 
below. The steps may vary slightly. Follow the on-screen instructions that 
apply to your operating system. 

1. Close all open Windows programs.
2. Open the Command Prompt window as administrator.
3. In the Command Prompt window, navigate to D:, where D: is the drive

containing the FactoryTalk Linx Gateway installation DVD or
installation package, and press Enter.

Tip: The User Account Control dialog box may show after you press Enter, click Yes to 
continue. The silent installation requires the Windows Administrator privilege. 

4. Type a command line with the following syntax:
Setup.exe {/Q | /QS}

/IAcceptAllLicenseTerms 
[/AutoRestart] 
[/SetupLanguage=language] 
/Product=product_name 
[/InstallDrive=drive] 
[/SerialNumber=serial_number] 
[/ProductKey=product_key] 
[/Version=product_version] 

5. Press Enter. The installation process starts with the parameters you
specified.

6. For detailed description about each parameter, see Parameters on page
79. You can also type Setup /? in the Command Prompt window, and
press Enter to view the help information of all parameters and
examples.

The parameters and values are not case sensitive. If the value includes spaces, 

Perform unattended 
installation 

Parameters 
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you need to enclose it in quotation marks (" "). 

/Q 

One of /Q and /QS is required if /Record is not specified. 

Installs the product in the silent mode without any user interface. 

/QS 

One of /Q and /QS is required if /Record is not specified. 

Installs the product in the unattended mode without user interaction 
during installation, and shows the progress, errors, or complete 
messages on the user interface. 

/IAcceptAllLicenseTerms 

Required for /Q or /QS. 

Specifies that you read and acknowledge all license agreements, and 
agree to continue the installation. 

/AutoRestart 

Optional. If specified, the computer will be restarted automatically 
after the installation, if a restart is required to complete the 
installation. 

The parameter is ignored if a restart is not required. 

/SetupLanguage=language 

Optional. Specifies which language will be displayed during the 
installation process. The value must be the one of ENU, CHS, DEU, 
ESP, FRA, ITA, JPN, KOR, or PTB. 

If omitted, the default language is the user or system user interface 
language. 

/Record 

Optional. Records your inputs to a recording file. 

/Playback 

Optional. Plays back a recording file. 

/IgnoreWarning 

Optional. If specified, the setup will ignore and continue. 

/Product=product name 

Required. Specifies which product will be installed. The product name 
must be one of the following: 

• Gateway Server OPC UA and DA (local or remote DA clients)
• Gateway Server OPC UA and DA (only local DA clients)
• Remote Gateway (DA Client remote configuration)



Appendix B Install FactoryTalk Linx Gateway with command line syntax 

Rockwell Automation Publication FTLG-GR001E-EN-E - March 2022 81 

/Uninstall=Product name 

Optional. Uninstall the product. 

/InstallDrive=drive 

Optional. Specifies the installation drive. 

If omitted, the default drive and location is: 

• C:\Program Files (x86)\Rockwell Software

/SerialNumber=serial_number 

Optional. Specifies the serial number that is required if you want to get 
activation keys during installation. 

/ProductKey=product_key 

Optional. Specifies the product key that is required if you want to get 
activation keys during installation. 

/Version=product_version 

Optional. Specifies the version corresponding to the product version 
that the SerialNumber and ProductKey are able to activate if you want 
to get activation keys during the installation. 

If the version information is omitted, the installer uses a default 
version which is the most recent product version available when 
retrieving the activation. 

For more details, please refer to the following list
• Setup.exe /Product="Gateway"

Equal to Setup.exe /Product="Gateway Server OPC UA and DA (local or 
remote DA clients)". Both will install “Gateway Server OPC UA and DA 
(local or remote DA clients)”. 

• Setup.exe /Product="Gateway-L"
Equal to Setup.exe /Product="Gateway Server OPC UA and DA (only 
local DA clients)". Both will install "Gateway Server OPC UA and DA 
(only local DA clients)".

• Setup.exe /Product="Remote Gateway"
Equal to Setup.exe /Product="Remote Gateway (DA Client remote 
configuration)". Both will install “Remote Gateway (DA Client remote 
configuration)”.
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• During the installation, the progress, error, or complete messages
show on user interfaces. The displayed language is Chinese.

• FactoryTalk Linx Gateway will be installed to D:\Program Files 
(x86)\Rockwell Software

• The setup will get activation keys during installation if the serial
number 0123456789 and product key ABCDE-FGHIJ are valid.

• After the installation, if a restart is required, the computer will be
restarted automatically.

Example 3 
Setup.exe /Q /Uninstall /Product="Gateway 
Server OPC UA and DA (local or remote DA 
clients)" 

means: 

• The software is uninstalled silently with no user
interface.

Examples

Example 2 
Setup.exe /QS /IAcceptAllLicenseTerms /
AutoRestart /SetupLanguage=CHS /Product="Gateway 
Server OPC UA and DA (local or remote DA 
clients)" /InstallDrive=D: /
SerialNumber=0123456789 /ProductKey=ABCDE-FGHIJ /

Version=6.30.00 
means

The FactoryTalk Linx Gateway unattended installation uses the default 
settings during the installation process, with no user interface. 

The following examples show how to use the commands during the 
unattended installation. 

Example 1 
Setup.exe /Q /IAcceptAllLicenseTerms /Product="Gateway 

Server OPC UA and DA (local or remote DA clients)" 

means: 
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Appendix C 

About FactoryTalk Linx 

This appendix includes an overview of FactoryTalk Linx. 

FactoryTalk® Linx™ is a FactoryTalk® Live Data server and communications 
service designed to deliver control system information from Allen-Bradley® 
control products to the Rockwell Automation FactoryTalk® software portfolio 
and Studio5000® design software. While FactoryTalk Linx can communicate 
with most Allen-Bradley Programmable Logic Controllers (PLC®) and many 
other control products, it is specifically optimized to work with Logix 5000™ 
Programmable Automation Controllers (PAC) and the PlantPax process 
controller using EtherNet/IP. This gives the fastest data rates and capacity 
possible, while minimizing the impact on automation networks and control 
system operation. FactoryTalk Linx provides a scalable solution that can 
support small applications running on a single computer with a single 
controller, to large distributed and even redundant data server configurations 
communicating with many controllers. 

FactoryTalk Linx: 

• Is delivered and installed with the FactoryTalk Services Platform 
(FTSP) which is included with most Rockwell Automation software 
products. FactoryTalk Linx is also delivered within the PanelView Plus 
Electronic Operator Interface (EOI) terminal’s firmware. 

 
Tip: The FactoryTalk Services Platform Installation includes several useful tools.  Use 
FactoryTalk Live Data Test Client to interface with FactoryTalk Linx to read and write data 
directly to controllers. For more information about FactoryTalk Live Data Test Client, see 
FactoryTalk Services Platform Online Help. 

• Is accessed as an embedded component within each software package 
that utilizes its services. Configure FactoryTalk Linx using the 
Communication Setup editor launched from a FactoryTalk application 
design environment (e.g. FactoryTalk View Studio) or from the 
FactoryTalk Administration Console.   

• Starting with version 6.00.00, EtherNet/IP network drivers can be 
configured directly from the FactoryTalk Linx Network Browser 
control embedded within Studio 5000 and other Rockwell Automation 
design software. 

• Provides access to controller and device data from any FactoryTalk 
application using FactoryTalk Live Data. 

• Is highly optimized for Logix 5000 communications. 
• Starting with version 5.30.00, supports FactoryTalk Alarms and Events. 

For more information about FactoryTalk Alarms and Events, See 
FactoryTalk Alarms and Events Online Help. 

About FactoryTalk Linx 
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• Starting with version 5.30.00, network applications provide the option 
of specifying a secondary, or redundant, server to take over when the 
primary server fails. 

• Starting with version 5.60.00, reads data directly from devices using 
parameters specified in the device’s Electronic Data Sheed (EDS) file 

• Starting with version 5.70.00, receives data from Logix 5000 
controllers directly via unsolicited message. 

• Starting with version 5.70.00, is able to communicate with Micro800 
controllers 

• Starting with version 5.80.00, reads energy usage information from 
devices that support the ODVA CIP Energy object. 

• Starting with version 5.90.00, reads Logix 5000 tag extended 
properties (e.g. @Min, @Max, @Description) and deliver them to 
FactoryTalk View applications. With FactoryTalk Linx version 6.10.00, 
this capability is enhanced to improve read performance and adds the 
ability to provide a description using information indirectly associated 
with a tag. This enables a FactoryTalk View SE client to obtain 
descriptions for tag elements that do not directly have a description 
assigned. This is similar to the description pass-through capability of 
Studio 5000 Logix Designer. 

• Starting with version 5.90.00, removes Logix 5000 tag requests when 
their external access is switched to no access in Logix Designer, and the 
tags can be removed from the controller while it is operating. 

• Starting with version 5.90.00, permits communications to specific 
Logix 5000 shortcuts to be inhibited to reduce the impact of Logix 
5000 controllers that are disabled or off-line 

• Starting with version 6.00.00, provides access to Logix 5000 tag based 
alarm attributes (e.g. @Alarm…)  

• Offers a variety of communication drivers and routing options. 
• Supports Local applications (also called stand-alone applications) for 

smaller systems, and Network applications (also called distributed 
applications) for larger systems. 

• Starting with version 6.00.00, enables the configuration of two 
redundant shortcut paths to a single Logix 5000 controller to support 
high availability systems that desire to retain communications when a 
path through a network becomes disabled. 

• Starting with version 6.00.00, permits configuration of two shortcut 
paths to the primary and secondary Logix 5000 controllers in a 
redundant ControlLogix revision 31.5x system to retain 
communications when a redundancy switchover occurs.  

• FactoryTalk Linx 6.00.00 added the ability to provide communications 
and browsing services for Studio 5000 and ControlFLASH. FactoryTalk 
Linx version 6.10.00 extends this functionality to support the 
Connected Components Workbench (CCW) version 12.00.00 and 
FactoryTalk AssetCentre version 9.00.00. 
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• FactoryTalk Linx version 6.00.00 updated both the Virtual Backplane 
and USB drivers and had them signed by Microsoft to permit them to 
operate on a workstation with Windows 10 Secure boot enabled. 
FactoryTalk Linx version 6.10.00 extends this functionality to include 
the drivers associated with the 1784-PCICS and 1784-PCKTS cards. In 
FactoryTalk Linx version 6.20.00, 1784-PKTX driver signed by 
Microsoft to support Windows 10 secure boot. 

• FactoryTalk Linx version 6.10.00 added a new standalone version of 
FactoryTalk Linx Network Browser that can be launched from the 
Windows Start Menu. Previously this component was only available 
from within other Rockwell Automation software (For example. 
ControlFLASH and Studio 5000 Logix Designer). The Network 
Browser can be used to visualize the network to determine which 
devices are active in the system. 

• FactoryTalk Linx version 6.10.00 added FactoryTalk Security Product 
Policy to provide more control over the configuration for authorized 
users. 

• FactoryTalk Linx version 6.10.00 added logging of FactoryTalk Audit 
messages to track configuration changes of FactoryTalk Linx. 

• FactoryTalk Linx version 6.10.00 supports a new capability in 
Logix5000 V32 controllers to change the names of tags and structure 
members on a running controller. When FactoryTalk Linx detects the 
rename operation, it will immediately stop requesting the old names 
and provide an appropriate error status back to the FactoryTalk 
software that requested the data, making it easier to locate other 
software that is impacted by the rename operation. 

• FactoryTalk Linx version 6.10.00 added the ability to receive 
unsolicited messages using PLC-2 Unprotected Writes. This enables 
Logix5000 or legacy controllers to send information to a FactoryTalk 
software package using FactoryTalk Linx. 

• FactoryTalk Linx version 6.10.00 changes the default setting for the 
“listen on EtherNet/IP Encapsulation port” (port 44818) for its Ethernet 
driver so that FactoryTalk Linx will respond to network browse 
requests and receive unsolicited messages from Logix5000 controllers. 
RSLinx Classic version 4.00.01 or earlier allocated this port by default 
but was updated with versions 4.10.00 to not allocate the port to reduce 
the likelihood of a conflict between these two software packages.  

• FactoryTalk Linx version 6.10.00 added the ability to configure two 
independent instances of the data service on a single Windows 
operation system. It allows applications to have more tags, data clients 
(e.g. HMI clients), and/or controllers without affecting the other 
FactoryTalk Linx data server. 

• FactoryTalk Linx version 6.11.00 added the ability to establish secure 
encrypted communications with FactoryTalk Policy Manager using 
CIP security. See FactoryTalk Policy Manager Online Help for more 
information about CIP security. 
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• FactoryTalk Linx version 6.20.00 added the ability to access 
information inside of devices that support the Open Device Vendors 
Association (ODVA) Common Industrial Protocol (CIP), using the 
Class, Instance and Attribute (CIA) messaging with the CIP Object - 
Class/Instance/Attribute Message shortcut type. 

• The FactoryTalk Security Policy for FactoryTalk Linx was enhanced to 
control the user’s capabilities from the FactoryTalk Linx Network 
Browser and to control access to CIA Messaging. 

• In conjunction with FactoryTalk Linx Gateway, provides standard OPC 
connectivity into the FactoryTalk system for third-party products. For 
more information about FactoryTalk Linx Gateway, refer to the 
FactoryTalk Linx Gateway Help.FactoryTalk Linx version 6.20.00 adds 
the ability to access information inside of devices that support the 
Open Device Vendors Association (ODVA) Common Industrial 
Protocol (CIP), using the Class, Instance and Attribute (CIA) 
messaging with the CIP Object - Class/Instance/Attribute Message 
shortcut type. 

• Starting from version 6.20.00, FactoryTalk Linx supports tag 
communication with data types as LINT, ULINT, LREAL, USINT, 
UINT, and UDINT. 

• Starting from version 6.20.00, FactoryTalk Linx instance02 supports 
Logix-based Alarms and Events. 

• Starting from version 6.20.00, FactoryTalk Linx provides the ability to 
communicate using solicited messaging with Allen-Bradley controllers 
using PLC-5 or SLC-5 messaging over the DH+ network without having 
a 1784-PKTX card installed on the computer. This is achieved by using 
the 1756 EtherNet module bridging across a ControlLogix chassis to a 
DH+ network connected to a 1756-DHRIO module. 

• FactoryTalk Linx version 6.20.00 adds the ability to configure existing 
drivers in FactoryTalk Linx Browser > Configure Drivers dialog box. 

• FactoryTalk Linx version 6.20.00 adds the ability to view new CIP 
Identity Object Manufacturer information, which include Catalog 
Number, Manufacture Date, Hardware Revision, Warranty, and 
Series. 

• FactoryTalk Linx version 6.20.00 adds FactoryTalk Audit information 
to diagnose configuration changes made from the FactoryTalk Linx 
Network Browser. 

• FactoryTalk Linx version 6.20.00 adds the ability for FactoryTalk Linx 
Network Browser to browse through the 5094 IO HART modules and 
display HART connected devices in the topology. 

• FactoryTalk Linx version 6.20.00 adds the ability for the FactoryTalk 
Linx Network Browser to access Device Statistics to help diagnose 
devices. 

• FactoryTalk Linx version 6.20.00 adds the ability for the FactoryTalk 
Linx Network Browser to access Device Configuration to help 
configure port and network configuration of a device. 
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• FactoryTalk Linx version 6.20.00 adds the ability the ability for the 
FactoryTalk Linx Network Browser to launch an Internet browser to 
open the device embedded web page. 

• FactoryTalk Linx version 6.20.00 provides the ability for FactoryTalk 
and PanelView Plus V12 terminals to access four attributes @Name, 
@Quality, @Timestamp, and @Scope. 

• FactoryTalk Linx version 6.20.00 adds the ability for FactoryTalk and 
PanelView Plus V12 terminals to access PlantPAX Controller extended 
tag properties: @Library, @Instruction, @Label, @Area, @URL, and 
@Navigation. 

• Starting from version 6.20.00, FactoryTalk Linx changed to utilize a 
device’s Network Path to store location of the device in a system, 
which enables the user to configure and store the shortcut path using 
the device's IP address and slot number in a chassis.  

• FactoryTalk Linx version 6.20.00 provides Chinese, German, French, 
and Japanese localized user interface (the localized FactoryTalk Linx 
can only be installed when installing the same localized version of 
FactoryTalk View SE). 

• FactoryTalk Linx version 6.20.00 adds the ability to close unused 
connections after a specified time. 

• FactoryTalk Linx version 6.20.00 adds the ability to specify the max 
number of connections for a Processor shortcut connecting to 
PLC/SLC controllers using the DHRIO module. 

• FactoryTalk Linx version 6.21.00 adds an About dialog box in 
FactoryTalk Linx Network Browser to show the version of the installed 
FactoryTalk Linx Network Browser and FactoryTalk Linx, or to view 
the copyright and contact information. 

• FactoryTalk Linx version 6.21.00 adds the ability to detect devices that 
support a user initiate LED blink operation and presents an option on 
the device property dialog to locate where a device is physically 
installed by flashing a device's LEDs. 

• FactoryTalk Linx version 6.21.00 adds an option to set the Terminal file 
transfer communication package size. User can choose either 2000 
bytes or 1400 bytes for the terminal communication package size 
(Default 2000). The smaller packet size improves the transfer time 
when FactoryTalk View Studio ME is operating within a virtual 
machine. 

• FactoryTalk Linx version 6.21.00 adds two predefined tags 
(@NamespaceTimestamp, @NamespaceTimestampOPC) to show a 
timestamp for the last Logix controller namespace change.  

• FactoryTalk Linx version 6.21.00 included a new tool named 
FactoryTalk Linx Configuration Import Export Tool, which enables 
the FactoryTalk Linx driver and shortcut configuration to be extracted, 
modified and replaced, providing an alternative to manually creating 
or editing the driver and shortcuts configuration from the FactoryTalk 
Administration Console user interface. 
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• FactoryTalk Linx version 6.21 supports to backup and restore shortcut 
and driver configurations in FactoryTalk Administration Console. 

• FactoryTalk Linx version 6.21 adds the ability to generate SysLog for 
select events include CIP Security configuration changes, network 
configuration changes, and FactoryTalk Linx service restart. 

• FactoryTalk Linx version 6.21.00 improved performance for design 
software that utilizing FactoryTalk Linx for communications direct to 
device (for example, Studio 5000 Logix Designer and ControlFLASH 
Plus).  

• In FactoryTalk Linx version 6.21.00, the FactoryTalk Linx Redundancy 
Module Configuration Tool can be launched from the FactoryTalk Linx 
Network browser. 

• FactoryTalk Linx version 6.30.00 adds an option to enable or disable 
CIP Security (Port 2221) for the server workstation or a device via the 
Network Browser. 

• FactoryTalk Linx version 6.30.00 supports browsing 5015 adapters and 
optimizes the user interface of 5015 adapters with their I/O modules. 

• FactoryTalk Linx Network Browser version 6.30.00 supports 
indicating the offline status of devices. 

• FactoryTalk Linx version 6.30.00 adds one predefined tag 
(@TrackedStateValue) to show the tracked state change detection 
value from a Logix L7 series controller. 

• FactoryTalk Linx version 6.30.00 adds an LLDP tab in the Network 
Browser to view and edit the Link Layer Discovery Protocol (LLDP) 
detection status of a device. 

• FactoryTalk Linx version 6.30.00 adds @RedundancyEnabled and 
@RedundancyState predefined tags associated with a processor 
shortcut, to indicate if the associated controller is operating in a 
ControlLogix Redundancy configuration and its current operational 
state. These tags are helpful for Human Machine Interface (HMI) 
displays that monitor the operation of a redundant ControlLogix 
controller’s operation. 

• FactoryTalk Linx Network Browser version 6.30.00 supports browsing 
of GuardLink connected devices. 

• FactoryTalk Linx version 6.30.00 removes the "IO Linx" 
communications driver. 

• FactoryTalk Linx version 6.30.00 enhances the configuration of port 
44818 that keeps the same configuration status in both FactoryTalk 
Linx and FactoryTalk Administration Console. 

• FactoryTalk Live Data version 6.30.00 extends the supported 
subscription rates to include 600, 700, 800, and 900 ms. 

• FactoryTalk Live Data version 6.30.00 adds leading zeros for array 
indexes so that FactoryTalk Live Data Tag browser sorts array elements 
in the proper numerical order. 

• FactoryTalk Linx version 6.30.00 raises the minimum DCOM 
authentication level to Packet Integrity. For additional information 
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about the affected Rockwell Automation products, see the 
Knowledgebase Document ID: PN1581 - Product Notification 
2022-01-001 - Rockwell Automation products unable to establish 
proper DCOM connection after installing Microsoft DCOM Hardening 
patch (MS KB5004442). 

• FactoryTalk Live Data common tag browser user interface included 
with FactoryTalk Services Platform version 6.21.00 now uses data type 
names that match the types presented in Studio 5000 Logix designer.   

For more information, refer to FactoryTalk Linx Help. 

 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1133982
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Appendix D 

Secure FactoryTalk Linx Gateway using 
FactoryTalk Security 

This appendix includes the following information: 

• About FactoryTalk Security 
• Using FactoryTalk Security with FactoryTalk Linx Gateway 
• Securing tag write access for FactoryTalk Linx Gateway 

FactoryTalk® Security improves the security of your automation system by 
limiting access to those with a legitimate need. FactoryTalk Security 
authenticates the identities of users, and authorizes user requests to access a 
FactoryTalk system against a set of defined user accounts and access 
permissions held in the FactoryTalk network directory or FactoryTalk local 
directory. 

For help configuring security services, refer to FactoryTalk Services Platform 
Help. 

If you prefer not to use security services, you can grant all users full access to 
your automation system. For help overriding security services, refer to 
FactoryTalk Services Platform Help. 

The FactoryTalk Linx Gateway Configuration tool enables you to start or stop 
the FactoryTalk Linx Gateway service and configure the scope. To configure 
security for the tool, in the FactoryTalk Administration Console, right-click 
the network (the highest level of the tree), and select Security from the menu. 

The following example shows the steps to restrict a user from changing the 
scope: 

Before you begin: 
• Log in as Windows Administrator or Power User of the computer. 
• Obtain Read/Write/List Children permissions within the Common 

section of Security. 
• Log in to FactoryTalk. 

To restrict a user from changing the scope: 
1. In the FactoryTalk Administration Console Explorer, right-click 

Network > Security. The Security Settings for Network dialog box 
opens. 

About FactoryTalk Security 

Secure the FactoryTalk Linx 
Gateway Configuration tool 
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For local scope, right-click Local (THIS COMPUTER) > Security. The 
Security Settings for Local dialog box opens. 

2. On the Permissions tab, select View permissions by User and you can 
see all the user groups (Administrators, All Users, Anonymous Logon), 
highlight the user you want to restrict. 

3. From the Permissions for *** from All Computers list, click Common > 
Write, and select the Deny check box. 

4. Click OK. 

Runtime actions are browsing, reading, or writing to tags. You configure 
security governing these actions using the Anonymous Logon user account at 
either the application level or area level. 

To browse the directory and read the data, the Anonymous Logon user must 
have List Children and Read permissions within the Common section of 
Security. 

To write to tags, the Anonymous Logon user must have Write Value 
permissions within the Tag section of Security. 

Keep the following in mind when securing runtime actions: 

• Security for the FactoryTalk Linx Gateway is set at the FactoryTalk Linx 
Gateway level using the Anonymous Logon user account. Therefore, all 
clients that access that specific FactoryTalk Linx Gateway will have the 
same privileges. If different clients need different privileges, then a 
second FactoryTalk Linx Gateway will need to be configured on 
another computer. 

• Security is area-based. It is a best practice to have only one data server 
per area. This allows you to place different permissions on each area 
(data server). 

• When configuring the scope for the FactoryTalk Linx Gateway, you 
should select the FactoryTalk Application, not an area. Selecting the 
scope at the application level enables you to add areas to that 
application without having to change the scope. Changing a scope 
affects all the existing tag references that have been previously 
configured in the clients. 

• You can deny both Read and Write access to areas. This is shown in the 
following example. 

Example 
Assume a Network-scoped distributed system. This system has a 
FactoryTalk Application called MyFTApp that contains three areas and 
three data servers. 
Assume the requirements for the OPC clients are: 

• Full access (Reads/Writes) allowed through FactoryTalk Linx. 
• No Reads allowed from the OPC client through RSLinx Classic. 
• No Writes allowed from the OPC client into the FactoryTalk View SE 

HMI (Reads are allowed). 

Secure runtime actions 
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To meet these requirements: 

1. The selected scope (using the FactoryTalk Linx Gateway 
Configuration screen) should be Network/MyFTApp. (Selected 
Scope field shows Network/MyFTApp.) 

2. Security for Area1 (using the FactoryTalk Administration Console) 
should be configured as follows: 

a. Under Application MyFTApp, right-click Area1 > Security to 
open Security Settings for Area1 dialog box, and then select 
Anonymous Logon user group. 

b. From Permissions for Anonymous Logon from All Computers 
list, select Common > Read > Allow. 

c. From Permissions for Anonymous Logon from All Computers 
list, select Common > List Children > Allow. 

d. From Permissions for Anonymous Logon from All Computers 
list, select Tag > Write Value > Allow. 

3. Security for Area2 (using the FactoryTalk Administration Console) 
should be configured as follows: 

a. Under Application MyFTApp, right-click Area2 > Security to 
open Security Settings for Area2 dialog box, and then select 
Anonymous Logon user group. 

b. From Permissions for Anonymous Logon from All Computers 
list, select Common > Read > Deny. 

4. Security for Area3 (using the FactoryTalk Administration Console) 
should be configured as follows: 

a. Under Application MyFTApp, right-click Area3 > Security to 
open Security Settings for Area3 dialog box, and then select 
Anonymous Logon user group. 

b. From Permissions for Anonymous Logon from All Computers 
list, select Tag > Write Value > Deny. 

If a write action is attempted into Area3, the following error is logged 
in FactoryTalk Diagnostics: 

"FactoryTalk Linx Gateway write failed due to denied access for 
client ‘Client1’ group ‘Group1 (Active, 250ms)’ item ‘Area3::my_int’. 
Verify you have the correct security authorization to perform the 
write operation." 

If you attempt to browse the FactoryTalk application, Area2 will not 
show since Read permissions have been denied. If your display has a 
tag previously referenced from Area2, its value will show as (Empty 
Data) with a Quality of Invalid Quality. The following errors are logged 
in FactoryTalk Diagnostics: 
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"Cannot interpret area RNA://$Global/MyFTApp/Area2 
(result=80042062) 
Failed to add item ‘[FTI_Advanced]my_tag’ to server 
RNA://$Global/MyFTApp/Area2:RSLC’ because of insufficient access 
rights." 

 
Tip: Access to resources (such as applications, areas, or servers) and the ability to perform 
tasks (such as read or write) are governed by the permissions set in FactoryTalk Security. 
As a result, if you do not have the appropriate permission, some components on a dialog 
box may be unavailable, or entire dialog boxes or context menu selections described in the 
Help may be inaccessible. Refer to the FactoryTalk Services Platform Help for more 
information. 

 

When using the Anonymous Logon, the system administrator can manage 
tag write access in an application, area, or sub-area for FactoryTalk Linx 
Gateway servers. Tag write access is enabled (Write Tag permission is set to 
Allow) by default.  

Before you begin: 
• Find the Anonymous Logon in Users and Group > Users. 
• Do not delete or change password. 
• Check Effective permissions to verify Rights for the Anonymous Logon 

user. 

To disable write access for an application, area, or sub-area: 
1. On the FactoryTalk Administration Console application tab, click the 

application, area, or sub-area. 
2. Right-click and select Security. The Security Settings dialog box 

opens. 
3. Select Anonymous Logon from the list of users. 
4. Click and expand Tag in the list of permissions to expose the Write 

Value permission. 
5. Select the Deny check box. 
6. Click OK. 

When using the Anonymous Logon, the system administrator can manage 
tag write access for a specific computer. Use the system administrator to 
specify permissions for each FactoryTalk Linx Gateway. 

Before you begin: 
• Find the Anonymous Logon in Users and Group > Users. 
• Do not delete or change password. 
• Check Effective permissions to verify Rights for the Anonymous Logon 

user. 

Secure tag write access for 
an application or area 

Secure tag write access for 
a computer 
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To disable tag write access for a computer: 
1. On the application window, select the application, area, or sub-area. 
2. Right-click and select Security. The Security Settings dialog box 

opens. 
3. Click Add. The Select User and Computer dialog box opens. 
4. Select Anonymous Logon from the list of users. If Anonymous Logon 

is not listed, select Show users only. 
5. Select the appropriate computer from the list, If computers are not 

listed, select Show computers only, and the click OK. 
6. Click and expand Tag in the list of permissions to expose the Write 

Value permission. 
7. Select the Deny check box. 
8. Click OK. 

Use the Policy Settings tab in Feature Security Properties dialog box to 
secure features of a single FactoryTalk product. By setting permissions to a 
single feature, you can limit a user or a group of users to perform securable 
actions. 

The logon scope is determined by the user's activation type. If a user has a 
local license, he can only log on to local scope. If the user has a network 
license, he can logon to both network and local scope. 

To log on FactoryTalk Linx Gateway server, do one of the followings 
• Click File > Log On. 
• Click Select next to FactoryTalk Diagnostics Scope on Server 

Configuration tab. 

 
• Note: If you have enabled single sign-on function in FactoryTalk Services Platform > Explorer 

> System Policies > Security Policy, there is no need to manually log on FactoryTalk Linx 
Gateway server. 

• Log off and log on back for the feature security settings to take effect. 

As the product policy is configured upon the logon scope, make sure the 
FactoryTalk Linx Gateway server logon scope is the same with FactoryTalk 
Diagnostics scope. 

The following table shows the relationship between FactoryTalk Linx Gateway 
feature security policies and securable actions that the user can perform: 

Feature security policy Allow Deny 

View Gateway Server Properties Allow users to view information in Server Configuration tab 
including: 
• FactoryTalk Diagnostics Scope 
• UA Server Service Name 
• UA Server status 
• Local Discovery Service URL and status. 
• DA Server status 

Hide UA Server and DA Server information. Users can only 
select scope in Server Configuration tab. 

Feature Security Properties 
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Feature security policy Allow Deny 

Modify Gateway Server Properties Allow users to edit in Server Configuration tab: 
• Change UA Server Service Name. 
• Inhibit UA Server communication. 
• Select if register with LDS. 
• Inhibit DA Server communication. 

Set Service Name area, UA Server Inhibit checkbox, 
Register with Discovery Service checkbox, and DA 
Server Inhibit checkbox unavailable. 

View UA Server Endpoint Properties Allow users to view UA server configuration information and security 
settings in UA Server Endpoints tab including the endpoints': 
• Name 
• Port 
• URL 
• Security Policy 
• Security Mode 
• Authentication Settings 
• Diagnostic Logging 

Hide the Endpoint Properties area. 

Remove UA Server Endpoint Allow users to remove the selected endpoint in UA Server Endpoints 
tab. 

Set the Remove button unavailable. 

Add/Configure UA Server Endpoint Properties Allow users to add a new endpoint and edit existing endpoints' 
configuration information and security settings in UA Server 
Endpoints tab including: 
• Name 
• Port 
• URL 
• Security Policy 
• Security Mode 
• Authentication Settings 
• Diagnostic Logging 

Set the Endpoint Properties area and the Add button 
unavailable. 

View Tag List Configuration Allow user to view tag list configuration in the UA Tag List tab User cannot configure tag list in the UA Tag List tab 

Modify Tag List Configuration Allow user to modify tag list configuration in the UA Tag List tab User cannot modify tag list in the UA Tag List tab 
Manage Incoming Certificate Allow users to view and import, reject, trust and remove certificates in 

Certificate Management tab. 
Set the Import, Reject, Trust, and Remove button as 
unavailable. 

View Outgoing Certificate Properties Allow users to view the outgoing certificates information in 
Certificate Management > Outgoing Certificate tab. 

Set the outgoing certificate properties unavailable. When 
switching to Outgoing Certificate tab, the Certificate 
Properties area still shows the Incoming Certificate 
properties. 

Modify Outgoing UA Certificate Properties Allow users to regenerate an outgoing certificate when the old one is 
expired or there is a need to do so. 

Set the Regenerate button as unavailable. 

OPC UA Client Read Access Allow OPC UA clients to read data values through FactoryTalk Linx 
Gateway server. 

OPC UA clients cannot read data values through 
FactoryTalk Linx Gateway server. An access denied error 
occurs during communication. 

OPC UA Client Write Access Allow OPC UA clients to read and write data values through 
FactoryTalk Linx Gateway server. 

OPC UA clients cannot write data values through 
FactoryTalk Linx Gateway server. An access denied error 
occurs when editing tag values. 
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Glossary 

A-F on page 97 

H-U on page 102 

 

- A -  

access path 
An access path defines the computer, driver, networks, and communication 
devices used to communicate with a destination device or processor in Object 
Linking and Embedding for Process Control (OPC) conversations. 

acknowledgment (ACK) 
An ASCII control character used to acknowledge the reception and acceptance 
of a transmission block. 

activate 
To make a Rockwell Software product active so that it can run without the 
limitations imposed by demonstration mode. Without activation, some 
Rockwell Software products will not run, some will run with diminished 
functionality, and others will run for a limited period of time and then shut 
down with or without warning. 

activation file 
A text file that contains all of the activation information that is required to 
license a software product and allow it to properly function. While the file is 
simply plain text, the contents of the file are protected by a signature. 

activation host 
The device associated with an activation by a unique ID. 

activation server 
An activation server is any computer that hosts concurrent activations. The 
activation server manages the activations and shares them with other 
configured computers on the network. 

A-F 



Glossary  
 

98 Rockwell Automation Publication FTLG-GR001E-EN-E - March 2022  
 

alias 
A logical name for a variable in a device or memory. Similar to a tag. 

application 
A machine or process monitored and controlled by a controller or the use of 
computer-based or controller-based routines for specific purposes. 

area 
An area organizes and subdivides a distributed Network application into 
logical or physical divisions. 

- B - 

baud 
A unit of signaling speed equal to the number of discrete conditions or signal 
events per second. Where one bit is encoded on each signaling event, the 
number of baud is the same as the number of bits per second. 

Block Check Character (BCC) 
An error checking method developed to improve error detection in data 
communications. The BCC is added to the end of each block of data before the 
block is transmitted. 

- C - 

Certificate 
A digital certificate is an electronic representation of an identity. A certificate 
binds the identities public key to its identifiable information, such as name, 
organization, email, username, and/or a device serial number. A certificate is 
used to authenticate the connection to other devices. Selected by default when 
CIP security is enabled. 
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CIA Messaging 
To access information inside of devices that support the Open Device Vendors 
Association (ODVA) Common Industrial Protocol (CIP), using the Class, 
Instance and Attribute (CIA) messaging with the CIP Object - 
Class/Instance/Attribute Message shortcut type. 

client 
A component or subsystem that uses data or functionality provided by some 
other component or subsystem (the server). The term can also refer to the 
computer that executes this software, connecting to a server computer across 
a communication network. 

Common Industrial Protocol (CIP) 
The Common Industrial Protocol (CIP) is an industrial protocol for industrial 
automation applications supported by ODVA. Previously known as Control 
and Information Protocol, CIP defines messages and services for the 
collection of manufacturing automation applications – control, safety, 
synchronization, motion, configuration and information. It is used in 
EtherNet/IP, DeviceNet, CompoNet and ControlNet. Extensions to CIP are 
CIP Safety, CIP Motion, CIP Security, and CIP Sync. 

CIP security 
CIP security has multiple layers of security that enables a CIP-connected 
device to protect itself from malicious CIP communications. Then the device 
can reject data that has been altered, reject messages send by untrusted 
people or untrusted devices, and reject messages that request actions that are 
not allowed. CIP security defines the notion of a security profile, which is a set 
of well-defined capabilities to facilitate device interoperability and end-user 
selection of devices with the appropriate security capability.  

concurrent activation 
A type of activation that allows multiple computers across a network to use 
Rockwell Software products at the same time. Concurrent activations include 
floating activations and borrowed activations.  
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configuration 
A file that contains information about the physical structure you defined for 
your system. This file includes all network paths, defined drivers and devices, 
Data Providers, and object protocols. 

cyclic redundancy check (CRC) 
A Cyclic Redundancy Check (CRC) is an error checking technique used by 
computers. 

- D - 
DA 

See OPC DA. 

data element 
An individually addressable item of data. For example, an OPC tag, an HMI 
tag, a graphic display, an event file, a node, and a channel. 

data provider 
One of the building blocks of FactoryTalk Linx, a data provider acts as a 
multiplexer for multiple clients and optimizes what data can be read together 
for more efficient handling. 

data server 
Data servers serve tags, or data items, contained in OPC-DA (Data Access) 
servers. Clients that need access to data items use data server application 
elements to locate the computers that are hosting OPC-DA 2.0 compliant data 
servers. 

DCOM 
Distributed Component Object Model (DCOM) is a proprietary Microsoft 
technology for communication between software components on connected 
computers. It allows a computer to run programs over the network on a 
different computer as if the program was running locally. 
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dongle 
A dongle is a security or copy protection device for commercial computer 
programs. When required by a program, a dongle must be connected to an 
input/output port, such as USB or parallel port of the computer, to allow the 
program to run. Programs that use a dongle query the port at start-up and at 
programmed intervals thereafter, and close if the dongle does not respond 
with the expected validation code. 

- E - 

Endpoint 
An endpoint represents the set of configuration settings on an OPC UA Server 
that determine how OPC UA clients will interface with the server. This 
includes a Universal Resource Locator (URL) string, Transport Control 
Protocol (TCP) port, security and data access settings. 

Encryption 
In cryptography, encryption is the process of encoding information. This 
process converts the original representation of the information, known as 
plaintext, into an alternative form known as ciphertext. Ideally, only 
authorized parties can decipher a ciphertext back to plaintext and access the 
original information. Encryption does not itself prevent interference but 
denies the intelligible content to a would-be interceptor. 

External Access 
A property that allows you to specify the level of access (Read Only, 
Read/Write, or None) external applications and devices have to tags. 

- F - 

floating activation 
A type of concurrent activation that requires a continuous network 
connection and allows multiple computers to use Rockwell Software products 
concurrently. An activation server manages a predetermined number of 
activations in a pool, and makes these activations available to any configured 
computer on the network. 
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When a computer connects to the network and runs a Rockwell Software 
product, it automatically "checks out" an activation from the pool of available 
concurrent activations. When the product shuts down, the activation is 
automatically freed and returns to the activation server's available pool. 
Checking out activations from the pool and returning them to the server 
happens automatically, without any user intervention. 

- H - 

HMI server 
The software module that is responsible for performing core run-time 
operations such as data collection, alarm detection, historical data logging 
and retrieval, and for providing FactoryTalk View SE Clients with graphic 
displays, run-time data, and events. 

- I - 

Incoming Certificate 
Certificate provided by an OPC UA clients to FactoryTalk Linx Gateway when 
the client initiates a communications request. Note that incoming certificates 
are not trusted until a user accepts or trusts them through the FactoryTalk 
Linx Gateway’s user interface. 

IP Address 
Each server or client on a TCP/IP internet is identified by a numeric IP 
(Internet Protocol) address. The two types of IP addresses are the IPv4 (IP 
version 4) address and the IPv6 (IP version 6) address. 

IP addresses are managed and allocated to users by the Internet Assigned 
Numbers Authority (IANA) and its delegates. The internet address specifies 
both the network and the individual host. This specification varies with the 
size of the network. An IP address identifies a machine in an IP network and 
is used to determine the destination of a data packet. Port numbers identify a 
particular application or service on a system. 

H-U 
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- L - 

Localized 
Software Localization is the process of adapting or translating software to a 
specific locale's language, culture, and legal requirements. Localization will 
require modifications to the user-visible components of software such as the 
user interface, images, documentation. 

- N - 

Namespace 
A collection of information that a Server makes visible to its Clients. 

Namespace index 
The numeric values used to identify OPC UA namespaces correspond to the 
index into the NamespaceArray. 

NodeID 
A numeric or text value that uniquely identifies a data value in an OPC UA 
Server. An OPC UA client will receive NodeIDs from an OPC UA server while 
browsing its namespace and will make read, write and subscription requests 
for data by delivering the NodID back to the OPC UA server.  

Network Interface Controller  
A network interface controller (NIC) is a computer hardware component that 
connects a computer to a computer network, typically a circuit board or chip. 

- O - 

OPC DA 
OPC (Open Platform Communications) Data Access (DA) is a non-proprietary 
technical specification that defines a set of standard interfaces based on 
Microsoft’s OLE/COM (Component Object Model) technology. Applying OPC 
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DA standards makes interoperability possible among automation and control 
applications, field systems and devices, and business and office applications. 

The FactoryTalk Services Platform supports and extends the OPC DA 3.0 
specification, which includes the ability to browse data items. 

For more information on OPC DA, see https://opcfoundation.org 

OPC test client 
A data connections test utility that shows whether you are using Remote OPC 
Client functionality. 

OPC UA 
OPC (Open Platform Communications) Unified Architecture (UA) is a 
platform independent service-oriented architecture that integrates the 
individual OPC Classic specifications into one extensible framework. 
Applying OPC UA standards makes interoperability possible among 
automation and control applications, field systems and devices, and business 
and office applications. 

For more information on OPC UA, see https://opcfoundation.org 

Outgoing Certificate 
Certificate generated by FactoryTalk Linx Gateway and delivered to OPC UA 
clients when they initiate a communications request. Note that many OPC UA 
clients require manual approval when they receive a certificate in order to 
enable communications with an OPC UA server. 

- P - 

poll 
Systematically request data from a device.poll 

poll rate 
Often how data is requested from a device. Poll rates are typical specified in 
milliseconds. (A poll rate of 1000 ms results in data being requested every 
second). 

https://opcfoundation.org/
https://opcfoundation.org/
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port number 
A port number is a way to identify a specific process to which an internet or 
other network message is to be forwarded when it arrives at a server. All 
network-connected devices come equipped with standardized ports that have 
an assigned number. These numbers are reserved for certain protocols and 
their associated function. 

- R - 

rehost (an activation) 
Rehosting an activation provides a way of moving an activation file from one 
computer or device to another. Rehosting an activation file deactivates the file 
on the computer that is hosting it, and then creates a rehost code 
that Rockwell Technical Support staff can use to generate a new activation file 
for use on another computer. 

- S - 

signing 
Cryptographic digital signatures use public key algorithms to provide data 
integrity. When you sign data with a digital signature, someone else can verify 
the signature, and can prove that the data originated from you and was not 
altered after you signed it. 

scope 
The level at which tags and routines may be created. They can be created at the 
controller level (accessible to all routines), or at the program level (accessible 
to only the routines within a single program). 

shortcut 
A symbolic reference to a physical device that you want to connect to on the 
network, and the data that device contains. The communication path 
associated with the shortcut tells the application where to find that data.  
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- T - 

TCP 
TCP (Transmission Control Protocol) is a standard that defines how to 
establish and maintain a network conversation through which application 
programs can exchange data. TCP works with the Internet Protocol (IP), 
which defines how computers send packets of data to each other. 

tag 
A named area of the process-connected device or controller’s memory where 
data is stored. It is the basic mechanism for allocating memory, referencing 
data from logic, and monitoring data. 

tag group 
A set of data items defined in the FactoryTalk Linx Gateway's UA Tag List 
interface that share a set of security settings enabling authorized OPC UA 
clients to access the data. 

topology 
The way a network is physically structured. This includes all networks, nodes, 
devices, Data Providers, drivers/channels, and object protocols. In FactoryTalk 
Linx, this is presented in tree form (the communications tree). 

trigger tag 
Configure a trigger tag to refresh destination tag. If the trigger tag value 
changes or trigger tag quality is changed to good (Update destination tags 
with refresh trigger quality changes checkbox is selected), the destination tag 
references for the current group will be refreshed. 

- U - 
UA 

See OPC UA. 
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UA tag list 
The UA tag list configuration determines the data values that each OPC UA 
Client can access from FactoryTalk Linx Gateway. The UA tag list option 
provides both enhanced security and complex type information (for example, 
structures and arrays). When the UA tag list option is disabled, all tags that 
are available from data sources in a FactoryTalk Application (for example, 
controllers and hardware via FactoryTalk Live, OPC DA and OPC UA servers) 
are accessible as scalar values to OPC UA Clients. The UA tag list contains one 
or more tag groups that define access rights and includes complex type 
information enabling an OPC UA Client to utilize structures or User Defined 
Types (UDT) from Logix controllers. 

URL 
A Uniform Resource Locator (URL) is a reference to a OPC UA Server that 
specifies its location on a computer network the TCP port used to interface 
with it.  
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Rockwell Automation support 
Use these resources to access support information. 

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 
updates. 

rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and find 
associated firmware. 

rok.auto/pcdc 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 

http://rok.auto/support
http://rok.auto/knowledgebase
http://rok.auto/phonesupport
http://rok.auto/literature
http://rok.auto/pcdc
http://rok.auto/docfeedback
http://rok.auto/pec

	FactoryTalk Linx Gateway Getting Results Guide
	Important User Information
	Table of Contents
	Preface
	About this publication
	Intended audience
	Find additional information
	Help
	Release Notes
	Knowledgebase
	Technical support
	Training programs
	Consulting services

	Legal Notices

	1 - Welcome to FactoryTalk Linx Gateway
	What is FactoryTalk Linx Gateway?
	Overview of basic concepts
	FactoryTalk Services Platform
	FactoryTalk Directory
	FactoryTalk Live Data
	FactoryTalk Diagnostics
	FactoryTalk Administration Console
	FactoryTalk Security
	FactoryTalk Activation Manager

	Application types

	Quick start: Set up and use FactoryTalk Linx Gateway

	2 - Install FactoryTalk Linx Gateway
	System requirements
	Hardware requirements
	Tested FactoryTalk Linx Gateway update rates
	Software requirements
	Software compatibility
	Prerequisite software

	System features
	Where to install FactoryTalk Linx Gateway
	Download a localized version of FactoryTalk Linx Gateway
	Chapter 3

	3 - About Remote FactoryTalk Linx Gateway
	Where to install Remote FactoryTalk Linx Gateway (OPC DA client computer configuration)
	Configure Windows firewall for Remote FactoryTalk Linx Gateway
	Install FactoryTalk Linx Gateway
	Change DA access
	Uninstall FactoryTalk Linx Gateway
	Update an existing installation
	Before you begin
	Upgrade FactoryTalk Linx Gateway
	Install Remote FactoryTalk Linx Gateway


	4 - Start FactoryTalk Linx Gateway and explore the user interface
	Application authentication level for DCOM security
	Start FactoryTalk Linx Gateway
	About the FactoryTalk Linx Gateway Configuration dialog box
	Server Configuration
	UA Tag List
	Set up and use UA Tag List
	Access configuration in UA Tag List
	Data type in UA Tag List and OPC UA/DA Client

	Select FactoryTalk Directory
	UA Server Endpoints
	About FactoryTalk Linx Gateway
	Certificate Management
	Advanced Settings
	FactoryTalk Diagnostic Log


	5 - Use FactoryTalk Linx Gateway to Access Data
	Before you begin
	Start FactoryTalk Linx Gateway
	Select the scope
	Access the data

	6 - Use FactoryTalk Diagnostics Counter Monitor with FactoryTalk Linx Gateway
	About FactoryTalk Diagnostics Counter Monitor
	Run FactoryTalk Diagnostics Counter Monitor
	Create a snapshot file
	Use FactoryTalk Diagnostics Counter Monitor to troubleshoot FactoryTalk Linx Gateway

	7 - Back up and restore FactoryTalk Linx Gateway configuration
	Back up FactoryTalk Linx Gateway configuration
	Restore FactoryTalk Linx Gateway configuration
	Use commands to back up and restore

	8 - Troubleshoot FactoryTalk Linx Gateway
	What to check first if difficulties are experienced
	Troubleshooting Tools
	FactoryTalk Linx Gateway Configuration Tool
	FactoryTalk Diagnostics
	FactoryTalk Diagnostics Counter Monitor
	FactoryTalk Live Data Test Client
	OPC Test Client

	Troubleshooting topics
	FactoryTalk Linx Gateway's OPC UA service does not appear in the OPC Local Discovery Service (LDS)
	FactoryTalk Linx Gateway activations
	FactoryTalk Security
	FactoryTalk Linx Gateway service (starting and stopping)
	Data quality
	Communication slow or unreliable

	Contact Rockwell Automation Technical Support
	Phone
	Worldwide web
	Hours of operation
	Before you call


	A - About Activations
	Activate FactoryTalk Linx Gateway
	Activation types

	B - Install FactoryTalk Linx Gateway with command line syntax
	Perform unattended installation
	Parameters
	Examples

	C - About FactoryTalk Linx
	About FactoryTalk Linx

	D - Secure FactoryTalk Linx Gateway using FactoryTalk Security
	About FactoryTalk Security
	Secure the FactoryTalk Linx Gateway Configuration tool
	Secure runtime actions
	Secure tag write access for an application or area
	Secure tag write access for a computer
	Feature Security Properties

	Glossary
	A-F
	H-U

	Index

	Back cover


<<

  /ASCII85EncodePages false

  /AllowTransparency false

  /AutoPositionEPSFiles true

  /AutoRotatePages /All

  /Binding /Left

  /CalGrayProfile (Dot Gain 20%)

  /CalRGBProfile (sRGB IEC61966-2.1)

  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)

  /sRGBProfile (sRGB IEC61966-2.1)

  /CannotEmbedFontPolicy /Error

  /CompatibilityLevel 1.6

  /CompressObjects /Tags

  /CompressPages true

  /ConvertImagesToIndexed true

  /PassThroughJPEGImages true

  /CreateJobTicket false

  /DefaultRenderingIntent /Default

  /DetectBlends true

  /DetectCurves 0.0000

  /ColorConversionStrategy /LeaveColorUnchanged

  /DoThumbnails false

  /EmbedAllFonts true

  /EmbedOpenType false

  /ParseICCProfilesInComments true

  /EmbedJobOptions true

  /DSCReportingLevel 0

  /EmitDSCWarnings false

  /EndPage -1

  /ImageMemory 1048576

  /LockDistillerParams true

  /MaxSubsetPct 1

  /Optimize true

  /OPM 1

  /ParseDSCComments false

  /ParseDSCCommentsForDocInfo true

  /PreserveCopyPage true

  /PreserveDICMYKValues true

  /PreserveEPSInfo true

  /PreserveFlatness true

  /PreserveHalftoneInfo false

  /PreserveOPIComments false

  /PreserveOverprintSettings true

  /StartPage 1

  /SubsetFonts false

  /TransferFunctionInfo /Apply

  /UCRandBGInfo /Remove

  /UsePrologue false

  /ColorSettingsFile ()

  /AlwaysEmbed [ true

  ]

  /NeverEmbed [ true

  ]

  /AntiAliasColorImages false

  /CropColorImages true

  /ColorImageMinResolution 300

  /ColorImageMinResolutionPolicy /OK

  /DownsampleColorImages true

  /ColorImageDownsampleType /Average

  /ColorImageResolution 300

  /ColorImageDepth -1

  /ColorImageMinDownsampleDepth 1

  /ColorImageDownsampleThreshold 2.00000

  /EncodeColorImages true

  /ColorImageFilter /DCTEncode

  /AutoFilterColorImages false

  /ColorImageAutoFilterStrategy /JPEG

  /ColorACSImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /ColorImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /JPEG2000ColorACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /JPEG2000ColorImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /AntiAliasGrayImages false

  /CropGrayImages true

  /GrayImageMinResolution 300

  /GrayImageMinResolutionPolicy /OK

  /DownsampleGrayImages true

  /GrayImageDownsampleType /Average

  /GrayImageResolution 300

  /GrayImageDepth -1

  /GrayImageMinDownsampleDepth 2

  /GrayImageDownsampleThreshold 2.00000

  /EncodeGrayImages true

  /GrayImageFilter /DCTEncode

  /AutoFilterGrayImages false

  /GrayImageAutoFilterStrategy /JPEG

  /GrayACSImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /GrayImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /JPEG2000GrayACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /JPEG2000GrayImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /AntiAliasMonoImages false

  /CropMonoImages true

  /MonoImageMinResolution 1200

  /MonoImageMinResolutionPolicy /OK

  /DownsampleMonoImages true

  /MonoImageDownsampleType /Average

  /MonoImageResolution 1200

  /MonoImageDepth -1

  /MonoImageDownsampleThreshold 1.50000

  /EncodeMonoImages true

  /MonoImageFilter /CCITTFaxEncode

  /MonoImageDict <<

    /K -1

  >>

  /AllowPSXObjects false

  /CheckCompliance [

    /None

  ]

  /PDFX1aCheck false

  /PDFX3Check false

  /PDFXCompliantPDFOnly false

  /PDFXNoTrimBoxError true

  /PDFXTrimBoxToMediaBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXSetBleedBoxToMediaBox true

  /PDFXBleedBoxToTrimBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXOutputIntentProfile (None)

  /PDFXOutputConditionIdentifier ()

  /PDFXOutputCondition ()

  /PDFXRegistryName ()

  /PDFXTrapped /False



  /CreateJDFFile false

  /Description <<

    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>

    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>

    /DAN <>

    /DEU <>

    /ESP <>

    /FRA <>

    /ITA <>

    /JPN <>

    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>

    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)

    /NOR <>

    /PTB <>

    /SUO <>

    /SVE <>

    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)

  >>

  /Namespace [

    (Adobe)

    (Common)

    (1.0)

  ]

  /OtherNamespaces [

    <<

      /AsReaderSpreads false

      /CropImagesToFrames true

      /ErrorControl /WarnAndContinue

      /FlattenerIgnoreSpreadOverrides false

      /IncludeGuidesGrids false

      /IncludeNonPrinting false

      /IncludeSlug false

      /Namespace [

        (Adobe)

        (InDesign)

        (4.0)

      ]

      /OmitPlacedBitmaps false

      /OmitPlacedEPS false

      /OmitPlacedPDF false

      /SimulateOverprint /Legacy

    >>

    <<

      /AddBleedMarks false

      /AddColorBars false

      /AddCropMarks false

      /AddPageInfo false

      /AddRegMarks false

      /ConvertColors /NoConversion

      /DestinationProfileName ()

      /DestinationProfileSelector /NA

      /Downsample16BitImages true

      /FlattenerPreset <<

        /PresetSelector /MediumResolution

      >>

      /FormElements false

      /GenerateStructure true

      /IncludeBookmarks false

      /IncludeHyperlinks false

      /IncludeInteractive false

      /IncludeLayers false

      /IncludeProfiles true

      /MultimediaHandling /UseObjectSettings

      /Namespace [

        (Adobe)

        (CreativeSuite)

        (2.0)

      ]

      /PDFXOutputIntentProfileSelector /NA

      /PreserveEditing true

      /UntaggedCMYKHandling /LeaveUntagged

      /UntaggedRGBHandling /LeaveUntagged

      /UseDocumentBleed false

    >>

  ]

>> setdistillerparams

<<

  /HWResolution [2400 2400]

  /PageSize [612.000 792.000]

>> setpagedevice





